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I NTERMED IATE INTRODUCT ION

COURSE DESCRIPT ION

This course covers the concepts and functionality you need to know in order to use the InEight
Estimate software successfully. As a result, you will be able to build cost estimates and bid proposals
with precision and efficiency.

COURSE OBJECTIVES

As a result of this course, you will be able to use the InEight Estimate software to:

l Review and report on project information

l Integrate with MS Excel and scheduling software (MS Project or Oracle Primavera)

l Manage quotes and use additional time-saving tools

HOW TO USE THIS MANUAL

This training manual serves as the working guide during the E101 Essentials of Project Modeling and
Estimating instructor-led course. The first seven lessons of this document follow a natural progression
of putting an estimate together, from set up of a project to finalization of a bid. The remaining lessons
cover additional functionality that will help you build and review your project estimate more
effectively.

LESSONS

The following lessons are covered in this course:



Course Lessons

Lesson Topic

Lesson 9 Reporting

Lesson 10 Data Reproduction

Lesson 11 Excel Integration

Lesson 12 Schedule Integration

Lesson 13 Cash Flow

Lesson 14 InEight Estimate Calculators

Lesson 15 Cost Item Assemblies

LESSON FORMAT

This manual is designed to be a “hands on” learning guide. As such, each lesson is organized into
sections:

Section Description

Objectives Specify what you will learn in each lesson.

Topics Organize the subject matter, with explanations of key concepts and terms.

Step by
Steps

Walk you through the “mechanics” of how to perform specific functions in the
software. For each step by step, you will use the Training Job that comes pre-
loaded in the InEight Estimate Estimating software.

Exercises Allow you to practice and reinforce what you learn. For each exercise, you will
use the Training Job that comes pre-loaded in the InEight Estimate Estimating
software.

Review Asks you questions to check what you have learned within each lesson.

CALL-OUTS

Throughout the document, you will also find important call-out banners.

Tips are for important notes and information you want to remember.
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Notes are for critical information you need to know.

ONGOING USE

This manual is also designed to be a comprehensive reference guide you can use outside of the
classroom and revisit as needed. Each lesson is compartmentalized so that you can refer back to each
lesson as needed.
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LESSON 9 — REPORT ING

LESSON DURATION: 30 MINUTES

LESSON OBJECTIVES

After completing this lesson, you will be able to:

l Run reports from the Reports menu

l Create and run reports from register forms



9 . 1 REPORTS MENU

InEight Estimate provides a lot of out of the box reports, referred to as “canned” or “system” reports,
that can help you review and analyze your estimate.

9 .1 .1 NON-MODAL REPORT DIALOG BOX

The Reports dialog is docked along with the other forms and registers. You can continue to work with
your estimate without being forced to close the Reports dialog box.

If the report becomes undocked, the job code shows in the reports dialog box header.

9 .1 .2 ADJUSTABLE REPORTS

Most of the reports within InEight Estimate can be adjusted to output the specific data and reporting
format you need. Each report has its own set of output settings for configuring and formatting the
report.

All InEight Estimate adjustable reports are accessed from the Reports menu. You may even run the
same report multiple times and choose different output settings based on what you want to see or
who the intended audience is.
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For example, you may choose to run the CBS Details Report several times to satisfy different needs or
for different audiences, and include or exclude specific data depending on what you or the report
recipients want to see.

l For a group of estimators, you may want to run a CBS Details Report that shows all cost and
productivity data for a job

l For field personnel, you may want to run a CBS Details Report that shows no cost data, but all
production and resource data

l Finally, for executive management, you may want to run a CBS Details Report that shows
summary level information only

The following steps take you through a brief overview of the Reports menu and how you can access it.

STEP BY STEP — GETTING TO THE REPORTS MENU

1. Open the Training Job, and select Setup tab.

l You access the Reports menu by clicking on the Reports icon

You can access the Reports menu from the Setup, Estimate, Quote, Price,
and Execution tabs.

2. Select Reports.

3. Here you select the Report of your choice. For this example, select the first option, Job
Properties.
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l You will see a split screen with the reports available on the left side bar

l The side bar on the left of the Reports form contains a “tree” of all InEight Estimate
adjustable reports
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l On the right, when you select a report node on the left, note that it displays the Output
Settings on the right side of the form, from which the report settings can be adjusted and
the report can then be run

4. Each report has a Print tab, a Layout tab and a Header/ Footer tab specific to that report.

l There are also Master Layout Settings and Master Header/Footer Settings located at the
bottom of the left-hand side bar tree. Here you can define settings that will apply to all
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reports

9 .1 .3 OUTPUT SETTINGS

This section provides a more detailed explanation of the output setting tabs.

9.1.3 .1 REPORT PRINTING OPTIONS

The Print tab includes three options for printing output: Print to Printer, Export to File, and Preview.
Export file outputs include PDF, Excel, text, and more.

PRINT PREVIEW

The Reports print previews opens in its own tab in the Report Dialog. This lets you keep the report
open while continuing to use other parts of the application.
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You can also undock and float a report on a different form, or you can tile it side by side with another
register to view and compare them.
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PRINT PREVIEW RIBBON

The Print Preview menu is displayed on its own ribbon. Menu commands are shown in the ribbon as a
contextual Print Preview menu when navigating to Reports > Print > Preview > Run.

9.1.3 .2 APPLY CUSTOM LAYOUTS AND HEADERS/FOOTERS TO
REGISTER REPORTS

You can apply custom Layouts and header/footers to register based reports. Upon saving a view in any
register, select the option to save it as a corporate view and include the view in the reports dialog box.
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When selecting a Saved View from the Reports register you can use the Print tab to customize the
printing preferences, use the Grid Options tab to change the font type/size, use the Layout tab to
modify the design style, and use the Header/Footer tab to insert a header and footer to your report.
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When you click on the Run button it will create a new register-style report. You can modify the layout
or header/footer directly in this register. You can also toggle between any of the four other tabs to
make modifications and see the changes on the saved view report.
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9.1.3 .3 REPORT LAYOUT SETTINGS

Many of the InEight Estimate adjustable reports include formatting options for the general layout of
the report, located under the Layout tab of the report’s output settings. Settings for the report include:
Orientation, Margins, Font, and Number Format.

9.1.3 .4 REPORT HEADER/FOOTER SETTINGS

Many of the InEight Estimate adjustable reports include the option to define and insert headers and
footers into the report. You can add information to the left, middle, or right of the header and footer
sections of the report.
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1. Once you define headers and footers, you can save them for use on other reports.

2. You can add page, time, and date stamps as needed, as well as images (e.g., company logo).

3. You can also use brackets to have it “stamp” the report with the Job Code and Job Description.

4. You can enter your own information as desired.

COVER SHEET FIELDS AND JOB FOLDER TAGS

In addition to the existing job code and job description tags in Job Properties, you can use the Cover
Sheet fields and Job Folder tags for your headers and footers in all standard reports.

Additional tag values such as contract numbers, work order numbers, PO numbers, company logos, or
any other tag fields can also be included. These additions help you customize headers and footers to
give the recipients more transparency in the reports.
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A Header and Footer field menu exists to the left of the Page Header and Page Footer grid, for all
standard reports. This lets you choose which fields from Job Folder Tags and the Cover sheet to include
in your report.

You can customize your header and footer layout settings, save them, and re-use them in other
reports.
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9.1.3 .5 REPORT DETAIL SETTINGS

Most reports have a Details tab with various options to configure what information is included on the
report.
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9.1.3 .6 SAVE OUTPUT SETTINGS

Once you’ve configured your settings for the report, you can save them as a custom version of that
report.
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The following steps walk you through configuring the settings and formatting for two different reports.
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STEP BY STEP — CONFIGURE REPORT OUTPUT SETTINGS (REPORT
1)

1. Open the Training Job and select Setup >Report>Resources.

2. Under Resources on the left side bar, select Resource Utilization.

3. On the Print tab there are three options. A best practice is to always set to Preview so you can
review before printing.
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4. On the Layout tab you can make adjustments based on your preferences.
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5. Move to the Header / Footer tab. Remove the default Report Title from the first page Header
only and enter Resource Utilization in the center Report Header box as a title that will appear on
the first page only.
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6. Go to the Details tab, and you can see the details and options you can select to customize and
adjust the report.

7. For this navigation, you will not Filter by currency; leave the selection as No Filter.

8. Under Report Type, choose the first option, Resource Utilization Summary.

l You can choose to select the Hide Zero quantity/cost Resources Employments Details box
if you prefer to have your printed report not show any resources that have a dollar value
of zero
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l You can choose if you want the report at a summary level, or if you want it to reference
your cost items when you are looking at a resource

l If you choose Resource Utilization Summary with Employed Cost Items, it adds CBS
position to the structure of the report

l You would select this if you wanted to see cost items and resources by the cost item

The Details settings are “sticky” features, meaning they default to what was
selected the last time.

9. You can use grouping to group by different tags and user-defined fields. Most of them are
related to the Resource Rate Register, for example: Geographic Area, Organizational Category,
Wage Zone, etc. For this example, group by Resource Organizational Category.

10. Next, you can choose the resources you want to see. For this example, select the Labor and
Construction Equipment Resource Types.
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l For this example, you will not make any selections under Columns or Details

l This is just one of many ways to organize and adjust your report.

11. Click Run to run the report.

l This report can be helpful for seeing your utilization hours, broken down by regular time
and overtime hours

12. Click the red X to close this page and open the Construction Equipment page.

13. Click the red X to close the Construction Equipment report.

STEP BY STEP — CONFIGURE REPORT OUTPUT SETTINGS (REPORT
2)

1. Open the Training Job and select Setup >Reports, then expand the Cost Breakdown Structure
node.
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2. Under Cost Breakdown Structure on the left side bar, select Estimate Summary.
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3. Along with the Print, Details, Layout, and Header / Footer tabs, there is an additional tab called
Cost Item Selection. Select this tab.

4. The Cost Item Selection tab allows you to report on a selection of cost items:

l Print a contiguous range of cost items:  Allows you to print a series of cost items in a row.
In this case, print just items: select 4.1 in the From field and 4.3.2 in the To field.

l Select cost items to print from the register below:  Allows you to use column filters to
select the cost items to include in the report; leave this button unselected.

5. You can roll up your cost items to a certain CBS level for the report as well, depending on the
level of detail you need.

6. On the Details tab, select Days for Cost item production field 1, andMan-Hours / UM for Cost
item production field 2 (this report allows you to report on two production values).

7. Under Resource Types, uncheck all of the boxes except Labor, ConstructionEquipment, and
Installed Material.
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8. Leave the rest of the settings at their defaults, then select the Header / Footer tab.

9. In the center Page Footer field delete the existing text, then type Confidential –Internal Use
Only.

10. To save the settings you’ve configured, click on the Settings drop-down arrow above the output
setting tabs.
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11. Select the Save disk icon to save the new settings.

12. Type Estimate Summary – Manager.

13. Click OK.

l Notice that a custom version of the report now displays under Estimate Summary on the
Reports tree on the left
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9 .1 .4 HELPFUL REPORTS

9.1.4 .7 PBS SUMMARY

Under the Price Breakdown Structure Report node, the PBS Summary Report gives a good overview of
how your price breaks down by cost category. This provides a high-level overview that is cost category
driven, providing information based on the total value of the project.

When selecting your settings on the Details tab, a best practice is to select and include:

l Cost Categories

l Markup Rate

l Percentage of Cost

This allows you to see your costs and markup broken out by cost category.
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You can also select to show markup rate and what percentage the markup is of your cost.

9 .1 .5 ACCESS CONTROL

You can use the Access Control report to audit user permissions, command access, and various
restrictions without having to search through the Access Control register for this information.
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9 .1 .6 STANDARD PROPOSAL

Located under the Pay Item & Proposal report node, the Standard Proposal report can be used for
contractors required to submit a pricing proposal to a client. It lists all the pay items with the client
provided quantities and your final pricing. You can include subtotals (defined on the Pay Item &
Proposal Register), cover sheet information, and a signature block.
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9 .1 .7 CBS DETAILS

Under the Cost Breakdown Structure report node, the CBS Details report can be a helpful report for bid
review. On the Details tab you can include or not include any of the information contained in the CBS
Register, including cost items with production, costs by category, shift arrangements, resources, and
notes.

9 .1 .8 AUDIT

Under the Job Tracking node, the Audit Report is a very important report to run during estimate review
to make sure you didn’t leave anything out of the estimate. It checks for a number of potential errors
in the estimate, including:

l Zero Price Pay Items

l Zero-value cost items

l Pay items without Cost Items assigned

l Resources with a quantity of zero
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EXERCISE 9.1 — RUN A SYSTEM REPORT

You can adjust InEight Estimate system reports to report on the particular information you need.
Complete the following steps to configure and run the Pay Item Summary report, using the Training
Job:

1. From the Reports window, expand the Pay Item & Proposal report node.

2. On the Reports tree, select Pay Item Summary.

3. On the Details tab, select a Pay Item Range from 303 4263 – 800 0220.

4. Choose to Include Assigned Cost Items.

5. Show Costs As: Unit.

6. Include Profit Analysis columns and Include Pay Item Price columns

7. Run the report.

You should end up with the following results
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Congratulations, you have completed this exercise!
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9 . 2 REG ISTER REPORTS

At any time, you can print a report of the data in the currently displayed register using the Print or
Preview option available from the Actions tab for the register you are in.

The data that prints is the data currently displayed on the register form. The report will print whatever
columns are displayed on the register; if you have customized the display in the register, the report
prints that data. In other words, register reports are entirely customizable.

By creating Saved Views, you can report the data on a register form in several different variations.

The following step by step example will walk you through creating a custom register report on resource
utilization and saving it as a Saved View.
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STEP BY STEP — CREATE A REGISTER REPORT

1. Open the Training Job and select Setup tab, then select the Resource Rates drop-down list.

2. From the drop-down list, select Labor.

3. From your Saved Views drop down menu on the Resource Rate Register, select the Print View
for Summary view.
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4. Notice this view includes utilization hours

5. Right-click on a column header and select Column Chooser.

InEight Inc.  |  Release 24.9 Page 35 of 240

Estimate Intermediate User Guide 9.2 Register Reports



6. From the Customization window, drag-and-drop theMinority Percent, Unique Sales Tax, (Scale
2), andMaint. Man-Hour Factor columns into the register.

7. Close the Customize window.

8. Sort the Utilization Count column by clicking on the column header twice so that you see the
bars descending.
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l This sorts your items so the most utilized resources are at the top

9. Click on the Saved Views drop-down menu and select the Save disc icon to save the view.

10. Name the view Labor Utilization View, and then click OK to save the customized view.

11. From the Actionsmenu, select Preview to review the report before printing.
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9 .2 .1 REGISTER REPORT OUTPUT SETTINGS

Within the Preview for a register report, there are several options to choose from to configure the
output of your report.

9.2.1 .1 PAGE SETUP

While in the Preview mode, selecting File > Page Setup provides setup options for the page format:

l Page Size (legal, letter, etc.)

l Paper Width & Height

l Orientation (portrait or landscape)

l Page Margins (left, right, top, bottom)

9.2.1 .2 EXPORTING TO DOCUMENT

Using the Export function allows you to identify a Print range, Image quality, Password Security, and
more. Selecting File > Export Document prints an Adobe Acrobat (*.pdf) report.
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EXERCISE 9.2 — CREATE A CUSTOM REGISTER REPORT

You can configure the columns in your registers for reporting and run your own custom reports.
Complete the following steps to configure and run a report from the CBS Register, using the Training
Job:

1. Select Estimate>Cost Breakdown Structure (CBS).

2. Under Saved Views, Select CBS Simple View.

3. Hide the Optional Code column.

4. Add back in theMan-Hours (Total) andMan-Hours / UM columns.

5. Now add back in the Labor Total Cost, Owned Equipment Total Cost, and Materials
Total Cost categories for reviewing the estimate.

6. Save the View (create your own name for the view).

7. Select Preview to view the report.

You should end up with the following results

Congratulations, you have completed this exercise!
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LESSON 9 REVIEW

1. The ___________ Report gives a good overview of how your price breakdowns by cost
category.

a. Estimate Summary

b. PBS Summary

c. Audit

2. The ___________ Report is a very important report to run during bid review to make sure
you didn’t leave anything out of the estimate.

a. CBS Details

b. Audit

c. Pay Item Summary

3. A best practice is to always set your Print output setting to Preview so you can review
before printing.

a. True

b. False

LESSON 9 SUMMARY

As a result of this lesson, you can:

l Run reports from the Report menu

l Create and run reports from register forms
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LESSON 10 — DATA
REPRODUCT ION

LESSON DURATION: 20 MINUTES

LESSON OBJECTIVES

After completing this lesson, you will be able to:

l Create a job from an existing job or template

l Create a template

l Reproduce estimate data using the Bid Wizard

l Reproduce estimate data using copy/paste

l Add cost items to a job using the CBS Bid Wizard

l Utilize the Snapshot function



10 . 1 COPY AN EX IST ING JOB

As you build an estimate, you may want to reuse pay items, cost items, or resources from a previous
estimate. When you plan to reuse the majority of content within a job, you can simply make a copy of
the existing job.

Using the Create a new Job from… Existing Job option on the Backstage View creates an exact replica
of the existing job, including the job’s properties, pay items, cost items, and resources.

The following Step by Step walks you through how to make a copy of an existing job.

STEP BY STEP — COPY AN EXISTING JOB

1. Click the File tab on the Estimate landing page.

2. From the left side panel, select New, then select Existing Job.

3. The Job Register displays a list of your existing projects; select the Training Job and click OK.
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4. On the New Job dialog, click the ellipses and select a Core Project.

5. In the Code field, type Infra Job Copy with your initials.

6. To copy the cost details from the existing job to the new job, verify that the Copy Cost Details
checkbox is selected

l If you wanted to copy just the cost item structure without cost details, you would uncheck
the box.

7. Uncheck the check for copying the PBS Changes Log, Copy Quotes and Auto-Update Job in
Connected Analytics.

8. Click OK to create the new job.

The new job opens with the Job Properties form active, so you can begin to modify the new job
as needed. If you look through the tabs on the Job Properties form, you will find that it looks
exactly like the job from which it was copied. Other forms, such as the Pay Item & Proposal
Register and the CBS Register, also look the same in both jobs until you make modifications in
one job or the other.
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This is a very easy method for creating a new job, and it is a good choice if you want to copy an
entire job. However, if you want to pick and choose which parts of a job to duplicate, the Bid
Wizard is a better choice.

10 . 2 TEMPLATES

Job Templates provide you the ability to maintain a list of template jobs that can be used to create new
jobs. As your company grows and increases the number of projects, the need to standardize the
estimating process increases to ensure consistency and reduce the chance of information being
overlooked.

In InEight Estimate you can create job folders and store them in a separate register as templates. This
allows you to store cost items in master templates separate from the jobs in your Job Register.

You can copy the template’s foundation setup data, such as account codes, tags, work breakdown
structures, and work group tags to your estimate. In Setup > Foundation Setup Data > Copy data from
another Job, select a template job to copy its foundation data.

The Copy data from another Job action includes jobs marked as Is Template.
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You can create templates from scratch or from existing job folders. The following steps walk you
through how to create a new template from an existing job folder.

STEP BY STEP — CREATE A TEMPLATE

1. Click the File tab on the Estimate landing page.

2. From the left side panel, select Templates.

3. Under Templates, select the Template Register.

4. From the Actions tab, select Create Template from Job.

l The Job Register opens for you to select the source job for the template

l Assume that you want to make a template from your E101 Training Job

5. Select the E101 Training Job with your initials, then click OK.
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You cannot create templates from jobs that are published to Job Tracking.

l The New Template From Job 'Training Job' with your initials prompt appears.

6. Click the ellipsis to the right of the Organization field.
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The Organization Register Library opens.

7. In the Organization Register Library, select an organization and then click OK.

8. In the Code field, type Small Project Template[your initials].

l Leave Copy Cost Details and Copy PBS Changes Log checked

9. Click OK.

l The new template is created and opens to the Job Properties form

l You can add the description in addition to the code for any new job you are creating from
a template. This description is later added to the Overview tab of the new job on the Job
Properties form

l Back in the Templates Register, you can see the new template created
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l Similar to copying an existing job, you can create a new job from a template
from the New menu in the Backstage View.

l You can also create a new job from a template from the New menu in the Bid
Wizard.

10. Select Add to existing job

11. From Select Source Job, click the dropdown arrow

12. Click Next

13. Select a job that is shown as having a Template

14. Click OK
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10 .2 .1 OBS FILTER TREE

The Template register's organization tree filter shows the templates assigned to a selected
organization.

Just like the job register, the list of templates is filtered based on the selected organization. The
primary difference between the OBS tree filter in the job and template registers is that estimates are
associated with projects in the job register, and projects belong to an organization. In the template
register, templates belong to an organization.
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10 .2 .2 ARCHIVE AND RESTORE TEMPLATES

The templates feature gives you the ability to archive and restore templates, enabling templates to
become portable. You can move templates between different environments. You can also backup the
templates similarly to the Jobs Archive and Restore function.

STEP BY STEP — ARCHIVE AND RESTORE A TEMPLATE

1. Click File to open the Backstage View.

2. Select Archive / Restore.

l Several options appear for archiving and restoring your jobs, templates, and library

3. Select Archive Template.

l The Template Register appears

4. Select the Small Project Template [your initials] template you previously made, then click OK.
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5. When prompted to include attachments, click Yes.

l The Save As window appears

6. Browse to where you want to save the job, then click Save.

7. Select Restore Template from the Archive / Restore page of the Backstage View to begin
restoring the template.

8. Browse to the archived template and select it.

9. Click Open.

l If the template already exists, a prompt will appear asking if you want to overwrite it

l To overwrite it, select Yes

l If you select No, you will be prompted to save it under a new Template Code

You can assign templates to specific organizational nodes in the OBS, grant permissions, and control
user access for templates.
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For example, you can assign a template to a specific node level in the OBS that is specific to Power
Delivery. The OBS node structure assignment is useful for assigning estimators access to designated
templates as determined by an Estimate administrator.
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Estimators with the appropriate Estimate/template permissions in Suite Administration > Roles and
Permissions > Master Data Libraries > Estimate, can use the templates in which they are assigned to in
their designated OBS node.
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STEP BY STEP — ASSIGN TEMPLATE TO OBS

1. Open the Training Job, then select the Templates.

2. Select Template Register.
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3. Select New.
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4. Click the ellipsis to the right of the Organization field.

The Organization Register Library opens.

5. In the Organization Register Library, select SF2090-Renewables, and then click OK.
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The new template will be set at the SF2090-Renewables node in the OBS. Users assigned to the
SF2090-Renewables level or above in the OBS will be permitted to use this template when
creating estimates.

6. The next step will be to create a new template code and a description to complete the new
template creation process.

What's next: After the template is created you can start to create estimates using a
template.
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10 . 3 B ID WIZARD

InEight Estimate’s Bid Wizard is a powerful tool that can help automate the process of setting up
estimates by copying information that already exists in other InEight Estimate job folders. The Bid
Wizard can be used to create new projects, create a new job from an existing template, or to add to
projects that are already underway.

Rather than copying every part of an existing job, the Bid Wizard gives you more flexibility and control
over which parts of a job you want to duplicate, e.g., pay items or cost items or both.

In most cases you will be copying cost items, but if you have a project with pay items that are
commonly used, you can copy them into a new project. If you select pay items, you will be able to
select cost items as well.

The following Step by Step walks you through how you can use the Bid Wizard to create a new job by
importing pay items and their associated costs from an existing job.

STEP BY STEP — USE THE BID WIZARD

1. To open the Bid Wizard, click the File tab on the Estimate landing page.

2. From the left side panel, select New, then select Bid Wizard.
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l The Bid Wizard – Step 1 dialog displays

Notice that you can either create a new project or add to an existing project.

3. Type E101 Bid Wizard (with your initials) in the New Code field.

4. Type Bid Wizard Example in the Description field.

5. Click the Next button.

l The Bid Wizard – Step 2 dialog displays

6. Choose Select cost items and click Next.
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l The Bid Wizard – Step 3 of 4 dialog displays

l You use this step to indicate which source you want to pull your setup data from (the
library or your source job)

7. For all selections, select Copy from source job.

8. Check the Also copy all non-utilized resources checkbox.

9. Select Copy from source job under Unassigned Cost Items and Markup, and the Copy Markup
box is automatically selected.
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10. Click Next.

l The Bid Wizard – Step 4 of 4 dialog displays

11. Click the Source Job drop-down arrow.
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l The Job Register opens

12. Find and select Training Job.

13. Click OK.

l This screen displays the cost items of the source job (Training Job). All items are
automatically selected

14. Use the Toggle Include All button to exclude all selections.

InEight Inc.  |  Release 24.9 Page 63 of 240

Estimate Intermediate User Guide 10.3 Bid Wizard



15. Select the checkboxes to includeMobilization, Clearing & Grubbing, and Unclassified
Excavation.

16. Notice that when selecting Unclassified Excavation, that cost item’s subordinates are
automatically selected
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17. Click Finish to add the new job.

l An Attention prompt appears asking, “Do you want to adjust Pay Rules and Shift
Arrangements of the copied cost items?”

l Typically, you will want to use the shifts and payment rules of your new destination job.

18. Select Adjust the pay rules and shift arrangements to match the destination.

19. Click OK.
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l A help bubble appears letting you know the job has been created, and that you can use
the ribbon tabs on the Estimate landing page to open any form

20. Close the help bubble by selecting the X in the upper right corner.

21. Open the Estimate > CBS to see the three cost items that were brought in.
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10 .3 .1 B ID WIZARD UPDATES

While using the Bid Wizard, the Include option is left unchecked by default. A filter is applied to bring
in pay items when using the Bid Wizard. The Toggle Include All button only selects the filtered list of
items instead of all items.

When the filter criteria is modified, the selected items remain checked even if some of the items might
not be visible in the view. When the view is changed, the selected items remain checked.

Tags and UDF fields are included in the Bid Wizard Selection register for the cost items and Pay Item &
Proposal selection registers. This lets you filter the list of cost items based on a tag or UDF.

When you select the Toggle Select All button, only filtered items are included which allow you to
include scopes of work relevant to your estimate without having to manually select all items needed.
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10 . 4 COPY EST IMATE DATA US ING ED IT
COMMANDS

While the Bid Wizard is an efficient way to copy cost history into new projects, you may prefer to use
edit commands such as copy and paste to bring cost history into your estimate.

To copy and paste cost history from one job to another, it is beneficial to see the jobs side by side. The
following steps walk you through the process.

STEP BY STEP — COPY ESTIMATE DATA USING EDIT COMMANDS

1. Click the File tab from the Estimate landing page and open the E101 Bid Wizard job you just
created.

2. Open the Training Job (if you do not still have it open).

3. Make sure the CBS is open for both jobs by going to the Estimate menu and selecting Cost
Breakdown Structure (CBS).

4. Since you have both jobs open and they are in their own application window, align them to be
side by side by using theminimize icons of each job or utilizing Windows align functionality.
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l Note that the window caption identifies the CBS Register for each job

5. On the CBS of the Training Job, click the row header on cost item 4 – Aggregate Base and press
Ctrl+C to copy the cost item.

When you copy a superior cost item, all of its subordinates are automatically
copied.

6. On the CBS of the E101 Bid Wizard job, click the row header on the first blank register row, and
press Ctrl+V to paste the cost item.
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7. On the Attention dialog, select Adjust the pay rules and shift arrangements to match the
destination and click OK.

l You can see in the destination job’s CBS that you’ve added the Aggregate Base cost item,
along with its subordinate cost items and all cost and productivity detail
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You can also drag and drop cost items from one CBS to another instead of
copying and pasting.

Copied cost items are considered Job Overhead until they are assigned to a
pay item

8. To go back to your full screen view of the E101 Bid Wizard job, select the maximize icon.

10 . 5 CBS B ID WIZARD

You can also use the Bid Wizard to add cost items while you are in the CBS Register. The following
steps walk through using the CBS Bid Wizard.

InEight Inc.  |  Release 24.9 Page 71 of 240

Estimate Intermediate User Guide 10.5 CBS Bid Wizard



STEP BY STEP — USE THE CBS BID WIZARD

1. Click the File tab from the Estimate landing page and open the E101 Bid Wizard job you created.

2. From the Estimate tab, select Cost Breakdown Structure (CBS).

3. Create a new cost item by typing New in the Description column on the bottom row of the CBS

4. Highlight the New row.

5. To open the CBS Bid Wizard, click the Bid Wizard icon on theMore Actions tab.

l The Bid Wizard window opens

6. Click in the Source Job column on the New cost item row.

7. From the Source Job drop-down list, select Training Job.

8. Scroll to the right of the Source Job column and click in the Source CBS Position Code column on
the New Cost item row.

l A source CBS Register window appears

9. Select CBS position code 5 – Asphalt Concrete Hot Mix Type A from the register.
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10. Click OK.

11. Click Finish on the Bid Wizard.

l An Attention prompt displays, asking if you want to make adjustments

l Keep the default options selected:Make Adjustments according to their quantity drivers
and cost drivers and Adjust the pay rules and shift arrangements to match the
destination

12. Click OK.

l You can see that cost item 5 and its subordinates are now imported into your existing job.

l You could choose a new name for the cost item, or name it Asphalt Concrete Hot Mix
Type A to match the original cost item
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10 . 6 SNAPSHOTS

A job snapshot is a copy of an estimate that provides read-only access to the job as it existed at a
specific point in time. You can now filter the Snapshot register to jobs containing snapshots.

The Snapshot register has some additional columns as well. In addition to the Code, Description, Last
Saved, and Version column, the Snapshot register contains all fields that are present on the Jobs
register that provides you with an easier way to group, sort, filter, and find the jobs you need.

10 .6 .1 SNAPSHOT REGISTER

The Snapshot Register is where you will view individual snapshots for specific jobs.

STEP BY STEP — SNAPSHOT REGISTER

1. Click theFile tab to open the Backstage View. In the panel, select Snapshots.

2. From the Snapshots form, select the Snapshot Register tab.
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3. To view individual snapshots for specific jobs, click the icon next to the desired job to display
the list of snapshots.
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10 .6 .2 CREATING A NEW JOB SNAPSHOT

STEP BY STEP — CREATE A NEW JOB SNAPSHOT

You can create a Job Snapshot from an existing Job.

1. From the Snapshots form, select the Create Snapshot tab.

2. If an existing job is open select Save, if you haven’t already done so.
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3. A New Job Snapshot [Job Code Here] dialog box appears. From there, you can add a Snapshot
comment.

l If you want to Include all Attachments that have been stored in the Job Folder with this
Snapshot, select the check box, otherwise uncheck the box.

l If you want to Use Job's current User Access restrictions for this Snapshot, select this radio
button.

l If you want to Remove User Access restrictions for this Snapshot and allow read-only
access to all users, select this radio button

l If you want to Specify User Access restrictions for this Snapshot (default selection), select
this option

l Then use the Add and Remove buttons to specify user access using Active Directory.
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(Users with current access to the job default onto the list.)

4. Click OK to create the snapshot.

5. A pop-up indicates when the snapshot has been created.
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10 .6 .3 EDIT ING A JOB SNAPSHOT

STEP BY STEP — EDIT A JOB SNAPSHOT

1. From the Snapshot Register, click the icon next to the desired job to display snapshots.

2. Right-click on the individual snapshot you want to edit and select Edit.

3. The same sort of dialog box opens up as when you created the Snapshot. In this case, from the
Edit Job Snapshot [Job Code Here] dialog box, modify the Snapshot Comment and the User
Access options as needed.

l If you want to Include all Attachments that have been stored in the Job Folder with this
Snapshot, select the check box. Otherwise, uncheck the box

l If you want to Use Job's current User Access restrictions for this Snapshot, select this radio
button

l If you want to Remove User Access restrictions for this Snapshot and allow read-only
access to all users, select this radio button

l If you want to Specify User Access restrictions for this Snapshot (default selection), select
this option

l Then use the Add and Remove buttons to specify user access using Active Directory.
(Users with current access to the job default onto the list.)

4. Click OK to update the snapshot.
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10 .6 .4 DELETING A JOB SNAPSHOT

STEP BY STEP — DELETE A JOB SNAPSHOT

1. From the Snapshot Register, click the icon next to the desired job to display snapshots.

2. Right-click on the individual snapshot you want to delete snapshots from and select
Delete.

3. Click OK

Alternatively, you can delete all Job Snapshots by clicking Delete All Job Snapshots from the
Actions tab.
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10 .6 .5 LOADING A JOB SNAPSHOT

When you load an existing Snapshot, it loads into Estimate as any other job.

STEP BY STEP — LOAD A JOB SNAPSHOT

1. Click the File tab to open the Backstage View, then select Snapshots.

2. From the Snapshots form, select the Snapshot Register tab.

3. On the Snapshot Register, click the icon next to the desired job to display the list of snapshots.

4. Right-click on the individual snapshot you want to load and select Load.

To identify a snapshot in Estimate as a read-only snapshot:
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l The job name is preceded by the label SNAPSHOT: centered on the top of the toolbar

l A red banner shows the specific snapshot information at the bottom of the screen

A snapshot can be modified, but it cannot be saved as it is read-only.

Page 82 of 240 InEight Inc.  |  Release 24.9

10.6 Snapshots Estimate Intermediate User Guide



EXERCISE 10.1 — DATA REPRODUCTION

Now that you have learned how to utilize the Bid Wizard, complete the following steps using the Bid
Wizard and Copy & Paste features.

1. Open the Bid Wizard by clicking the Bid Wizard icon from theMore Actions tab.

2. Choose the Create a new job radio button.

3. Type BW Exercise (with your initials) in the New Code field and type Exercise in the
Description field.

4. Choose Select cost items.

5. For all selections, choose Copy from source job.

6. Select the Also copy all non-utilized resources checkbox.

7. Select Copy from source job under Unassigned Cost Items and Markup, and the Copy
Markup box is automatically selected.

8. Find and select Training Job and click OK.

9. Use the Toggle Include All button to exclude all selections.

10. Select the checkboxes to include Cost Items 4-7.

11. Click Finish to add the new job.

12. Select Adjust the pay rules and shift arrangements to match the destination.

13. Open the CBS to see the cost items that were brought in.
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14. Open the Infra Job Copy with your initials that you created earlier in this lesson.

15. Copy Cost items 8 and 9 and paste them into the BW Exercise job.

You should end up with the following results
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Congratulations, you have completed this exercise!
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LESSON 10 REVIEW

1. From the New option on the Backstage View, which of the following options are available
for creating a new job? (Select all that apply)

a. Scratch

b. Template

c. Import

d. Existing Job

e. Historic

f. Bid Wizard

2. Which of the following job reproduction options lets you pick and choose which cost
items you want to import into your new job?

a. Template

b. Bid Wizard

c. Existing Job

d. Archive

3. Which of the following options allows you to add cost items from another project when
working in the CBS Register?

a. Bid Wizard

b. CBS Bid Wizard

c. Template

d. Existing Job

LESSON 10 SUMMARY

As a result of this lesson, you can:

l Create a job from an existing job or template

l Create a template
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l Reproduce estimate data using the Bid Wizard

l Reproduce estimate data using copy/paste

l Add cost items to a job using the CBS Bid Wizard

l Utilize the Snapshot function
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LESSON 11 — EXCEL
INTEGRAT ION

LESSON DURATION: 20 MINUTES

LESSON OBJECTIVES

After completing this lesson, you will be able to:

l Export data from InEight Estimate to Excel

l Link a field in InEight Estimate to Excel

l Update a linked InEight Estimate field with Excel data



11 . 1 EXPORT TO EXCEL

InEight Estimate's integration with Microsoft Excel includes a two-way integration that allows you to
update register fields in InEight Estimate with data contained in an Excel workbook, and update Excel
cells with data contained in a register column in InEight Estimate.

InEight Estimate includes a worksheet export that makes it easy to transfer data out of InEight Estimate
register forms to Microsoft Excel spreadsheets. This feature makes it faster and easier to send data
from an InEight Estimate register to a spreadsheet, analyze it, modify it, and customize it for any other
uses.

The Export to Excel feature is available on all register forms in the system and allows you to export the
data currently displayed on a register form to an Excel worksheet.

STEP BY STEP — EXPORT DATA TO AN EXCEL WORKBOOK

1. Open the Training Job and from the Estimate tab, open the CBS Register.

2. From the Actions tab, select Export to Excel.

3. On the Export spreadsheet to... dialog, browse to the location (folder) in your system where you
want to save the workbook, enter CBS Export in the File name field, and click Save.

l The workbook is saved to that location with the specified file name, and Excel
automatically launches and displays the workbook
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l Notice that the columns are formatted, with column headers and filtering turned on

11 .1 .1 CELL SELECT

To copy and paste data in InEight Estimate or to Excel, you can use a feature called Cell Select. Walk
through the following steps to learn how to copy specific fields in InEight Estimate to an Excel
Spreadsheet.

STEP BY STEP — CELL SELECT

1. Open the Training Job and from the Setup tab, open the Resource Rate Register.

2. Select the Labor tab.

3. Select Print View for Summary from your Saved Views drop-down menu.

4. From the top-right corner, select the Cell Select icon, (next to the Help icon).
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l This puts you in “cell-select” mode, so you can select cells to copy in the same way you
would in Excel.

5. With the Cell Select icon active, highlight all information in the Description, Utilization Count
and Unit of Measurecolumns for all Labor resources.

6. Right click on the selection and select Copy.

7. Open an Excel spreadsheet, right click in the A1 field and select Paste Special, choosing CSV as
the Source.
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8. Click OK.

l The fields you copied from InEight Estimate paste into the spreadsheet

l To turn off the Cell Select, simply click the Cell Select Icon again and it deselects
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11 . 2 L INK ING TO EXCEL

11 .2 .1 INE IGHT ESTIMATE WORKBOOK

Every job has its own Excel workbook embedded within it for doing side calculations and take-offs. You
can link your calculations to fields in InEight Estimate to automatically update them into your estimate.
When you create a new job from scratch, the Library Master Workbook is copied to create a new
embedded Excel workbook for the job.

The workbook comes with some pre-defined take-off and analysis worksheets, or you can create your
own. Simply open the appropriate worksheet, plug in your values, and Excel will calculate your results.
To open your job’s workbook, select the Estimate tab, then click on the Workbook icon under the
Workbook section.
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l The embedded Excel workbook for the job opens.

11 .2 .2 L INK ING TO AND FROM EXCEL

InEight Estimate's linking capabilities with Excel can be done in one of two ways. A field in InEight
Estimate can be populated with a value from Excel, or a cell in Excel can be populated with the data
from an InEight Estimate field. This two-way linking functionality allows you to make quick work of
complex chores to perform spreadsheet-based take-off or formula-driven analysis.

The following example walks through how to link a simple take-off calculation into InEight Estimate
from Excel. It is a take-off to determine the size of a concrete foundation.
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STEP BY STEP — LINK ESTIMATE TO EXCEL

1. Open the Training Job and from the Estimate tab, open the CBS Register.

2. For this example, create a new cost item in the blank row at the bottom of the CBS register and
name it Concrete Foundation.

3. Open the job’s Excel workbook from the Estimate tab, by selecting the Workbook icon.

4. In the workbook, create a new worksheet named Concrete Take-off and enter the following
fields:

5. Create a new row to calculate the total cubic yards by factoring the length, width, and height
quantities.
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l Your Volume Total should be 50 cubic yards

6. InEight Estimate will only link to named fields in Excel. Click in the field you want to name (B6),
then click in the Field Name window and type Volume.

7. Go back to the CBS Register and right click on the Concrete Foundation cost item Forecast (T/O)
Quantity field.

8. From the resulting right click menu, select Link this field to Excel.

l You can also link the field by selecting the field and then selecting Link Field from the
Actions tab

InEight Inc.  |  Release 24.9 Page 97 of 240

Estimate Intermediate User Guide 11.2 Linking to Excel



9. On the Link to Excel dialog, select the Update InEight Estimate field from Excel radio button.

10. In the Field to link window, select Volume (you may need to click the Refresh button for the
field name to display).
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11. Click OK.

l The Forecast Quantity field for Concrete now is linked to the Volume field in Excel and
populates with the take-off quantity (50)

11 .2 .3 UPDATE L INKS

When data in InEight Estimate or Excel changes, you can quickly update all links, in just the currently
active job or in all open jobs.  Simply select one of the following options from the Workbook drop-
down list on the Estimate tab.
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LESSON 11 REVIEW

1. The Export to Excel feature is available on all register forms in the system and allows you
to export the data currently displayed on a register form to an Excel worksheet.

a. True

b. False

2. In order to link an Excel field to InEight Estimate, the Excel field must be:

a. Named

b. Highlighted

c. Tagged

d. Selected

LESSON 11 SUMMARY

As a result of this lesson, you can:

l Export data from InEight Estimate to Excel

l Link a field in InEight Estimate to Excel

l Update a linked InEight Estimate field with Excel data

InEight Inc.  |  Release 24.9 Page 101 of 240

Estimate Intermediate User Guide Lesson 11 Review



This page intentionally left blank.

Lesson 11 Summary Estimate Intermediate User Guide



InEight Inc.  |  Release 24.9 Page 103 of 240

LESSON 12 — SCHEDULE
INTEGRAT ION

LESSON DURATION: 45 MINUTES

LESSON OBJECTIVES

After completing this lesson, you will be able to:

l Set up scheduling options

l Update schedule from InEight Estimate

l Update InEight Estimate from schedule

l Manage changes between estimate and schedule



12 . 1 M ICROSOFT PROJECT

12 .1 .1 SET UP SCHEDULING OPTIONS

Prior to sending information from InEight Estimate to Microsoft Project, you need to make sure the
proper settings are in place.

12.1.1 .1 JOB PROPERTIES SCHEDULE TAB

Microsoft Project scheduling options are configured on the Schedule tab of the Job Properties form.

l At the top of the Schedule tab, the Integrated Schedule must be set toMicrosoft Project

l As a default, the Always use Plug Days when updating InEight Estimate from the schedule
checkbox is not selected (on a job by job basis, this box can be checked later for jobs in which an
estimator does not want updates from Microsoft Project to change the duration and therefore
the cost of your cost items in InEight Estimate)

12 .1 .2 SCHEDULE COST ITEMS

Before you can integrate with Microsoft Project, your cost items need to be marked as Scheduled in
InEight Estimate. This is done on the Cost Breakdown Structure (CBS) Register. From your Saved Views
drop-down list in the CBS, the Schedule Setup View displays all of your schedule-related columns.
There are a couple to keep in mind when you schedule your items:
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l Scheduled:  This column tells you which of your items are selected to be included in your
Microsoft Project schedule.

l Roll Up Schedule:  This column lets you check a box to roll up your estimate to the selected level
when it imports into Microsoft Project.

In the below example, notice that all of the cost items are scheduled, but the subordinates for
Unclassified Excavation will be rolled up to the superior level.

The following steps walk you through scheduling your cost items.

STEP BY STEP — SCHEDULE A COST ITEM IN INEIGHT ESTIMATE

1. In the Training Job, from the Estimate tab, select Cost Breakdown Structure.

2. In the Saved Views drop-down list, select Schedule Setup View.

l In the Scheduled column, you can select the checkbox for each cost item that you want to
schedule

l If a cost item has subordinate cost items below it, you will only be able to check the
superior cost item, which will automatically schedule the subordinate cost items along
with it
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3. Select theMobilization, Clearing & Grubbing, and Unclassified Excavation cost items, then
press Tab.

STEP BY STEP — SCHEDULE A GROUP OF COST ITEMS IN INEIGHT
ESTIMATE

1. In the Training Job, from the Estimate tab, select Cost Breakdown Structure.

2. From the Saved Views drop-down list, select Schedule Setup View.

l To schedule multiple cost items, you can highlight the row for each cost item that you
want to schedule, using the Shift and Ctrl keys to select multiple rows.

3. Select additional cost items 4-Aggregate base, 5- Asphalt Concrete Hot Mix, and 6- 36-inch RCP
Culvert Class.
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To schedule all cost items, highlight the JOB row

4. Right click on the selected rows and select Schedule Selection.

l On the Schedule Cost Items dialog, you can select whether or not you want to roll up the
selected cost items to a specific level of the CBS for scheduling purposes

5. Select Schedule selected cost items and their subordinates without rolling them up, then click
OK.
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l Your scheduled cost items will import into Microsoft Project the next time you update
Microsoft Project from InEight Estimate.

12.1.2 .2 ROLL UP SCHEDULE

For cost item 3 – Unclassified Excavation, your scheduler does not need all of your estimate details and
wants to roll up your cost items to a higher level when they import into the Microsoft Project schedule.

Follow the steps below to learn how to roll up your cost items for the schedule.

STEP BY STEP — ROLL UP SCHEDULE

1. In the Training Job, from the Estimate tab select Cost Breakdown Structure.

2. From the Saved Views drop-down list, select Schedule Setup View.

l Review your cost items to decide which cost items need to be rolled up

3. Select the Roll Up Schedule checkbox on the Unclassified Excavation cost item.

12 .1 .3 UPDATE MICROSOFT PROJECT FROM INEIGHT
ESTIMATE

Now that you have set up your schedule to integrate with Microsoft Project in Job Properties and
scheduled your cost items in the CBS, you are ready to send your project information to Microsoft
Project.
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When you first update Microsoft Project from InEight Estimate, Microsoft Project will create a new
project automatically and load it with the following information from InEight Estimate:

Data Sent from InEight Estimate to Microsoft Project

Data Type InEight Estimate Microsoft Project

Project Data Job Code Project Name

Activity Data CBS Position Code 01 – CBS Position Code

Description Description

Days (Duration Driven) Duration

Cost Data Cost Category Total Cost Cost Category (custom text columns)

The following steps walk you through updating Microsoft Project from InEight Estimate to create a new
schedule.

STEP BY STEP — UPDATE MS PROJECT FROM INEIGHT ESTIMATE

1. From the Estimate tab, select Schedule>Update Project from InEight Estimate.
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l Your job automatically opens in Microsoft Project

l The Work Breakdown Structure Layout displays for the project

l You can see the breakdown structure imported from InEight Estimate with durations,
rolled up as specified by the Roll Up Schedule option in InEight Estimate

l Initially, the start date for your activities is the start date defined on the Job Properties >
Cover Sheet tab (these will change as activity relationships are defined)

12 .1 .4 UPDATE INEIGHT ESTIMATE FROM
MICROSOFT PROJECT

You can also bring information back from Microsoft Project into InEight Estimate. When you update
InEight Estimate from Microsoft Project, the following information updates:

Update InEight Estimate from Microsoft Project

Data Type Microsoft Project InEight Estimate
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Update InEight Estimate from Microsoft Project

Activity Data Start Dates Start Dates

Finish Dates Finish Dates

Hours Hours

Walk through the following steps to practice updating InEight Estimate from Microsoft Project. You will
create a scheduling relationship in Microsoft Project and then import the updated dates and
relationships into InEight Estimate.

STEP BY STEP — UPDATE INEIGHT ESTIMATE FROM MS PROJECT

1. Open your version of the Training Job project in Microsoft Project.

l In the real world, it is likely that you would have overlapping activities or your activities
would be out of order, however for this example you will link all activities from finish to
start

2. Click on the Link Tasks icon to link all activities.

l Ensure the Auto Schedule button is selected
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3. To update InEight Estimate with this change, go back to InEight Estimate and from the Estimate
tab, select Schedule>Update InEight Estimate from Project.

l On the Schedule Setup View, you can see the Start and Finish dates updated from MS
Project.
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12 .1 .5 EXPORT COPY OF MS PROJECT FILE

If your project’s schedule is integrated with MS Project, you can export a copy of your MS Project file.
This can be advantageous if a preliminary schedule is needed for a starting point schedule, as the
project goes into execution. Recreating the schedule from scratch can be time consuming and error
prone, as the existing schedule details might not be properly captured in the beginning stages.

12 .1 .6 MANAGE CHANGES BETWEEN ESTIMATE AND
SCHEDULE

As changes to scope, resources, and costs come up in your estimate, and changes to relationships and
dates occur in the schedule, you can continue updating your estimate and schedule as needed.

12.1.6 .3 PLUG DAYS

The Schedule Plug Days option allows you to define the duration in the schedule separate from the
duration defined for your cost items on the Production tab. For example, your 10” PVC Pipe activity
may have extra days in the schedule due to the delivery date of the pipe material, but you don’t want
those extra days to drive the costs in your estimate, since your crews won’t be working on the activity
on those extra days.

All superior cost items are hard-coded to use Schedule Plug Days.
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STEP BY STEP — SCHEDULE PLUG DAYS

1. Look at the Days (Duration driven) column in the CBS where it shows 4.65 days for Excavate RCP
Trench.

2. Make sure the Schedule Plug Days checkbox is selected on the Excavate RCP Trench cost item,
and then enter a Plug Days duration for the number of days the item will be scheduled in
Microsoft Project (7 days).

l This allows you to maintain your duration of 4.65 days in the estimate and 7 days in the
schedule.

Any duration changes made in Project will import into InEight Estimate as Plug Days
automatically so that they can be reviewed by the estimator before making any changes to
production in InEight Estimate.

12.1.6 .4 UPDATE MICROSOFT PROJECT WITH INEIGHT
ESTIMATE CHANGES

The following steps will walk you through updating the schedule with a scope change in your estimate.

STEP BY STEP — UPDATE MS PROJECT WITH INEIGHT ESTIMATE
CHANGES

1. In the InEight Estimate Training Job, from the Estimate tab, select Cost Breakdown Structure.

l In this scenario, there is a scope change for your Excavation requiring you to change all of
your quantities

2. Change the quantity in the Forecast (T/O) Quantity field in the CBS as specified below.
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Quantity Change for Cost Item

CBS Code Description Old Quantity New Quantity

5 Asphalt Concrete Hot Mix Type A 35,000 25,000

l As you make your changes, take note of how your duration changes in the Days (Duration
driven) column for these items.

l If prompted about changing Total or Unit Cost, select Change TOTAL cost, so that your unit
costs stay intact

3. From the Estimate tab, select Schedule>Update Projectfrom InEight Estimate to send the
changed hours to Microsoft Project.

4. Go back to the Training Job in Microsoft Project.

l The Microsoft Project scheduled duration should have changed from 4.65 days to 7 days to
match the updated duration in InEight Estimate for Excavate RCP Trench

l You can also see that the days for Asphalt Concrete Hot Mix Type A and its subordinates
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adjusted because you adjusted the Forecast T/O Quantity in InEight Estimate

5. Your Start and Finish dates are different now. In InEight Estimate, from the Estimate tab, select
Schedule >Update InEight Estimate from Project to update InEight Estimate with the new dates.
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LESSON 12 REVIEW

1. Under the Job Properties > Schedule tab, which setting can be enabled to account for
plugged costs (e.g., for subcontractors)?

a. Resource price/unit

b. Expense Costs

c. Schedule ID

d. Actuals

2. For InEight Estimate schedule integration with Primavera, which of the following can be
sent from your estimate to the schedule? (Select all that apply)

a. Activity data

b. Cash Flow graphs

c. Resource data

d. Cost data

e. Price data

3. The Schedule Plug Days option allows you to define the duration in the schedule separate
from the duration defined for your cost items on the Production tab.

a. True

b. False

LESSON 12 SUMMARY

As a result of this lesson, you can:

l Set up scheduling options

l Update Schedule from InEight Estimate

l Update InEight Estimate from Schedule

l Manage changes between estimate and schedule
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LESSON 13 — CASH FLOW

LESSON DURATION: 25 MINUTES

LESSON OBJECTIVES

After completing this lesson, you will be able to:

l Interpret cash flow and resource utilization on the Cash Flow graph

l Select Cash Flow Options

l Change Cash Flow Display Settings



13 . 1 CASH FLOW OVERV IEW

The Cash Flow form provides a graphical representation of the cash flow and resource utilization of
your project, so you can quickly assess financing and resource needs.

You can open the Cash Flow form by selecting the Estimate tab from the Estimate landing page, then
selecting Cash Flow from the Schedule section.

In order to generate a cash flow curve the estimate must be populated with schedule dates either
directly from integration with Primavera, Microsoft project, or input manually.

Section Description

1 The graph displays the projected cash flow of your project, along with job financing
expense, individual cost category costs and resource utilization.

l The x-axis measures time
l The left y-axis measures amounts
l The right y-axis measures quantities (when resource utilization is displayed)
l All graphs depicted on the Cash Flow form can be displayed based on Pay
Quantity or Forecast (T/O) Quantity

2 Click on the Display Settings icon to indicate what to display on the graph.
l You can display total costs and price or specific cost categories
l You can also set the display settings to report on Resource Utilization

3 Click on the Cash Flow Options icon to specify revenue timing, cost timing, and
cost of money.

4 Click the Excel icon to export the numerical data represented on the graph into an
Excel spreadsheet where you can run additional analysis.

5 You can filter the Cash Flow graph by date range or by a range of cost items.

6 Click and drag over the graph to zoom in on a particular section. Click the Reset
Zoom button to restore the graph to its original state.

Overview – Cash Flow Form
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13 . 2 CASH FLOW OPT IONS

The Cash Flow Options are used to define the cash flow rules (revenue timing, cost timing, cost of
money, and quantities) needed to calculate the finance expense and cash flow for your project.

Cash flow rules (revenue timing, cost timing, cost of money, and quantities) describe how cash flow
occurs between a contractor and a client, and between contractors or owners and
vendors/subcontractors. Cash flow is then calculated based on both the earning and payment terms
you specify, and the job's schedule and pay item prices.

To open the Cash Flow Options, click on the Cash Flow Options icon in the Tools section of the
Actions tab.

You can also access Cash Flow Options from the Setup > Job Properties > Cash Flow tab.
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1. Revenue timing:  Revenue is the amount of money actually paid to a contractor by the client for
the completion of project deliverables. This section contains options to specify when and how
often payment is recieved.

2. Cost Timing:  Cost is the amount of money expended to complete the scope of the project. This
section contains options to specify when and how often you pay contractors, subcontractors and
vendors.

To include any of your costs in your cash flow (including indirect costs), they need
to be scheduled

3. Cost of Money:  Represents the financing cost to fund the project. This section contains fields to
specify interest rates you pay for the money you borrow, and interest rates you earn for money
invested, to determine a total Finance Cost.

4. Quantities: Allows you to calculate cash flow based on pay quantities or forecast (T/O)
quantities.

5. Dates: By default, the scheduled Early Start and Early Finish dates of each cost item (and its
resource employments) as listed in the CBS Register, provide the timing of the expenses,
revenue, and costs that show up on the Cash Flow graph. You have the option to base cash flow
timing on Start/Finish dates or Late Start/Finish dates.
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13.2.0 .1 CASH FLOW OPTIONS SET UP

The following steps walk you defining settings on the Cash Flow Options form.

STEP BY STEP — CASH FLOW OPTIONS SETUP

1. In the E101 – Training Job, from the Estimate tab, select Setup >Job Properties >Cash Flow.

l You will see the default options already there

l You will adjust a few of those options

2. Change your Revenue timing to Every month on the 10th.
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l The average calendar days from billing to collection should be set to 25 days

3. For Cost timing, bills are received from subcontractors and vendors Every month on the 25th.

l Average calendar days elapsed from receipt of invoice to payment should be set to 30 days

4. For Cost of money, enter 10% for the Average annual interest rate paid to borrow money (when
cost exceeds revenue) and 2% for Average annual interest rate earned (when revenue exceeds
cost).

5. Leave all remaining options as originally defaulted.

13 . 3 CASH FLOW DISPLAY SETT INGS

13 .3 .1 COST ITEMS AND COST CATEGORIES

The Cash Flow Display Settings allow you to control what information displays on the Cash Flow graph.
To open the Display Settings click on the Actions > Display Settings icon in the Tools section.
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Section Description

1 You can save your display settings for future use.

2 Select how the graph measures the timing of your cash flow. Options include:  Day,
Week, Month, Quarter, and Year.

3 Under the Cost Items section, you can select:
l Total Cost (Forecast):  The total cost of your scheduled cost items, based on
when your costs are accrued (when your cost items are scheduled). This is
displayed as a dashed line on the graph

l Total Price (current):  The total revenue of your pay items, based on when
the revenue is earned (when your cost items are scheduled). This is displayed
as a dashed line on the graph

l Total Cost (Forecast) – Cash:  The total cost of your scheduled cost items,
reflecting the cost timing you specify in the Cash Flow Options. This is
displayed as a solid line on the graph

l Total Price (current) – Cash:  The total revenue of the pay items, reflecting
the revenue timing you specify in the Cash Flow Options. This is displayed as
a solid line on the graph

l Cash Flow:  Displays the difference between your Total Cost – Cash and Total
Price – Cash values, so you can see if you are making or losing money

l Finance Cost:  Displays the Cost of Money amount calculated from the
settings you specify in the Cash Flow Options

4 You can check the Estimated box for any specific cost categories you need to
display.

l The other check boxes are used for InEight Estimate Performance

Overview – Cash Flow Display Settings – Cost Items and Cost Categories
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13.3.1 .1 CASH FLOW DISPLAY SET UP

The following steps walk you through setting up your Cash Flow Display Settings.

STEP BY STEP — CASH FLOW DISPLAY SETTINGS SET UP

1. In the E101 – Training Job, from the Estimate tab, select Cash Flow from the Schedule section.

2. On the Actions tab, select Display Settings to open the Display Settings window.

3. From the Period drop-down list, selectWeek.

4. Under the Cost Items section, make sure the following are selected:

l Total Cost (Forecast)

l Total Price (Forecast)

l Total Cost (Forecast) – Cash

l Total Price (Forecast) – Cash

l Cash Flow
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l Finance Cost

5. Under the Cost Categories section, check the Estimated checkbox for the Labor and Owned
Equipment categories.
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6. Click OK to close the Display Settings window.

l Your Total Cost (Forecast) displays as a dashed red line, indicating your accrued costs
based on when your cost items are scheduled and the assigned cost curves for each cost
item.

l Your Total Price (current) displays as a dashed green line, indicating the revenue you’ve
earned, based on the timing of your pay items

l Your Total Cost (Forecast) – Cash displays as a solid red line, indicating your costs, based
on when your cost items are scheduled and the cost timing defined in Cash Flow Options

l Your Total Price (current) – Cash displays as a solid green line, indicating your revenue,
based on the timing of your pay items and the revenue timing defined in Cash Flow
Options

l Your Cash Flow displays grey bars indicating when your cash flow is negative or positive
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l Your Finance Cost displays as a blue line on the graph

7. To filter your graph by date range, click on the Start drop-down arrow and select a start date of
your date range filter.

8. Click on the End drop-down arrow and select an end date of your date range filter.
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l Your graph now only includes your cost items that fall within the specified date range

9. To remove the filter, click in the Start field and press the Backspace key.

10. Do the same for the End field.

13 .3 .2 RESOURCE UTIL IZAT ION

You can also use the Cash Flow graph to report on resource utilization. For example, you may want to
run a report that displays a work hours curve for a particular labor trade or to see the peak usage times
for a particular piece of heavy equipment.

You can run resource utilization graphs based off of any of the following:

l Resource Type

l Resource Code

l Description

l Organizational Category

l Tag 1, 2, and 3

l Quote Group

l Account Code and Cost Item Account Code

l Fuel Type

You set up your resource utilization settings from the same Display Settings window you use for setting
up Cash Flow, Display Settings in the Tools section of the Actions menu.
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13.3.2 .2 RESOURCE UTILIZATION DISPLAY SET UP

The following steps walk you through setting up your Cash Flow graph to report on Resource
Utilization.

STEP BY STEP — RESOURCE UTILIZATION DISPLAY SETUP

1. In the E101 – Training Job, from the Estimate tab, select CashFlow from the Schedule section.

2. On the Actions tab, select Display Settings to open the Display Settings window.

3. Make sure the all checkboxes are unchecked under the Cost Items and Cost Categories sections.

4. Under the Resources section, check the Resource Utilization checkbox.

5. From the Summarize resources by drop-down list, select Description.
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6. From the resulting list of Values, select Laborer.

7. Click in the Qty field for the selected value and select a color of your choice.

l In this case the Qty represents the work hours for your Laborer resource

8. Click in the Cost field for the selected value and select a different color of your choice.

9. From the Quantity and Cost drop down lists, you can select how your quantities and costs will
display on the graph. In this case select the Quantity to display as a Bar and Cost to display as a
Line.

Page 132 of 240 InEight Inc.  |  Release 24.9

13.3 Cash Flow Display Settings Estimate Intermediate User Guide



10. Click OK to close the Display Settings window.

l The graph now displays the utilization of your Laborer resource, showing the work hours
and costs used over time

The graphs displayed on the Cash Flow form are based on the estimated cost of each cost
item and its resource employments (in the case of resource utilization).
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LESSON 13 REVIEW

1. Under what cash flow form can you set up your revenue and cost timing?

a. Cash Flow Options

b. Display Settings

c. Worksheet

d. Page Setup

2. By default, the red dashed line on the Cash Flow graph represents the:

a. Total Cost (Forecast)

b. Total Price (current)

c. Total Cost (Forecast) – Cash

d. Total Price (current) - Cash

3. In the Cash Flow Display Settings, Resource Utilization allows you to view a graphical
summarization of your resources by which of the following? (Select all that apply)

a. Resource File Description

b. Resource Type

c. Resource Code

d. Description

e. Wage Zone

f. Organizational Category

LESSON 13 SUMMARY

As a result of this lesson, you can:

l Interpret cash flow and resource utilization on the Cash Flow graph

l Select Cash Flow Options

l Change Cash Flow Display Settings
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LESSON 14 — INE IGHT EST IMATE
CALCULATORS

LESSON DURATION: 20 MINUTES

LESSON OBJECTIVES

After completing this lesson, you will be able to:

l Use the Haul Calculator

l Use the Trench Calculator

l Use the In-Field Calculator



14 . 1 HAUL CALCULATOR

The Haul Calculator allows you to enter the specifics of up to three haul routes (distance, travel speed,
etc.). Once entered, you can either:

l Calculate the number of trucks required to complete the haul in a set amount of time, or

l Calculate how long it will take to complete the haul with a set number of trucks

The following activity walks step by step through using the Haul Calculator to calculate the number of
trucks needed for a cost item.

STEP BY STEP — HAUL CALCULATOR – CALCULATE QUANTITY OF
TRUCKS

1. Open the Training Job and from the Estimate tab, select Cost Breakdown Structure.

2. Open cost item 4.1 – Furnish & Haul Base Material.

3. On the Cost Item Record, click the Detail tab.

4. Right click on the ETDT – Dump Truck row header and select Open Haul Calculator.
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5. On the Haul Calculator, select the Calculate quantity of ETDT required to complete haul in
duration entered below radio button. (ETDT is the resource code for the Dump Truck you
selected.)

6. For the Haul Distance, type 5.

7. Enter an Average Payload (Ton) of 30.

8. For Load Time (Minutes), type 3.

9. Enter a Travel Speed Full of 35Mile/Hour.

10. For Dump Time (Minutes), type 2.
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11. Enter a Travel Speed Empty of 45 Mile/Hour. Notice this calculates a cycle time of 20.24.

12. Enter aWork Efficiency of 90 percent.

l The calculator shows a result of 1.56 concurrent haulers
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13. Click OK.

14. Your cost item now shows a quantity of 1.56. Round up the Quantity to 2. Also, adjust the
Teamster Quantity to 2 (if needed).

STEP BY STEP — HAUL CALCULATOR – CALCULATE TOTAL DURATION

1. Open the Training Job and from the Estimate tab, select Cost Breakdown Structure.

2. Open cost item 4.1 – Furnish & Haul Base Material.

3. On the Cost Item Record, click the Detail tab.

4. Change your Teamster and Dump Truck quantities back to 2 each.

5. Right click on the ETDT – Dump Truck row header and select Open Haul Calculator.

6. On the Haul Calculator, select the Calculate total duration of haul using quantity of ETDT
entered below radio button.

l With the previous information you entered still there, the calculator calculates a total
duration of 281.08 hours
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7. Click OK.

l The Hours field on the Production tab updated to 281.08

l Your ETDT Dump Truck quantity remains at 2

14 . 2 TRENCH CALCULATOR

The Trench Calculator allows you to quickly calculate trench, pipe, and bedding values. You can
perform pipe-related take-off by defining the details of the trench (e.g., length, depth, width, hinge
elevation, backslope, and swell factor), the pipe (diameter, elevation, and waste factor), and up to four
beddings.

With this information, the Trench Calculator can automatically calculate:

l Total excavation volume (neat-line)

l Total excavation volume (including swell/shrinkage)
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l Total pipe to purchase

l Lift Volume (for up to four beddings)

l Lift Weight (for up to four beddings)

You can use these calculations to define certain cost item setup data:

l You can use the Total Excavation Volume that is calculated as the quantity of the cost item

l You can use the Total pipe to purchase calculation as the quantity of a resource (e.g., pipe) that
has been employed to the cost item

l You can use the Lift Volume or Lift Weight that is calculated as the quantity of a resource
employed to the cost item in either cubic yards or tons

l You can click the Toggle English / Metric button at the bottom of the dialog to switch between
the English and Metric systems for entering data

You can access the Trench Calculator from the Actions tab of a Cost Item Record

When copying cost items in a job or from job to job, the Trench Calculator variable data is
included with the data being copied. When a cost item is copied to the clipboard, Trench
Calculator variable data is also included.

14 .2 .1 TRENCH CALCULATOR – TRENCH TAB

The following steps walk through using the Trench Calculator to take-off excavation volume.

STEP BY STEP — TRENCH CALCULATOR – TRENCH

1. Open the Training Job and from the Estimate tab, select Cost Breakdown Structure.

2. Create a new cost item from the bottom row of your CBS and call it 24” Pipe.

3. Add the following three subordinates and update their Units of Measure:

l Excavate Trench: CY

l Install Pipe: LF

l Backfill Trench: CY

4. Open the Excavate Trench Cost Item Record. Add the following resources:

InEight Inc.  |  Release 24.9 Page 141 of 240

Estimate Intermediate User Guide 14.2 Trench Calculator



l LL2  Laborer – 1

l LO2  Operator Class 2 – 1

l EX245  Excavator 245 – 1

5. Adjust the Production to: 100 CY/Hour.

6. On the Cost Item Record’s Actions tab, select Trench Calculator.

7. For Trench Length, type 1000.00 feet.

8. For Trench Width (at the bottom) type 4.00 feet.

9. Enter a Trench Depth of 10.00 feet.

10. Enter a Hinge Elevation of 5.00 feet.

11. Enter a Backslope of 45 degrees.

12. Define theMaterial Swell/Shrinkage Factor (fraction expressed as a decimal) at .10.

l You can select either a “neat-line” total volume or include swell/shrinkage

13. Select the “Total excavated volume (including swell/shrinkage)” checkbox.
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14. Click Save Configuration to Library and save the Trench calculator as Trench Example with your
initials.

15. Click OK.

14 .2 .2 TRENCH CALCULATOR – P IPE TAB

You can also use the Trench Calculator to take off how much piping and bedding you need for the
trench.

STEP BY STEP — TRENCH CALCULATOR – PIPE

1. On the CBS Register, adjust the Forecast T/O Quantity for the Install Pipe cost item to 1000 LF.

l Assume this quantity is based off manual take-off calculations you already did

2. Open the Install Pipe Cost Item Record.

3. Add the Resource Assembly of CPIPE - Pipe Crew and adjust the production to 300 LF / Day.
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4. On the Cost Item Record’s Actions tab, select Trench Calculator.

5. Select Load Configuration from Library.

6. Select Trench Example (with your initials).

7. Click OK.

8. On the Trench Calculator, select the Pipe tab.

9. Enter the following for the size and position of the pipe:

l Pipe exterior diameter:  26.00 inches

l Pipe center elevation (from bottom):  19.00 inches

l Waste factor: 10%

10. Click on the resource icon to pull up the Resource Rate Register.

11. Select the Installed Material tab.

12. SelectMPP24 Pipe 24” PVC SDR35, then click OK.

l The Pipe variables you entered should match the following image:
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13. Click Save Configuration to Library and save the Trench calculator as Trench Example with your
initials.

14. When prompted to overwrite the existing saved file, click Yes.

15. Click OK to close the Trench Calculator.

14 .2 .3 TRENCH CALCULATOR – BEDDINGS TAB

The following steps walk you using the Trench Calculator to calculate bedding take-offs.

STEP BY STEP — TRENCH CALCULATOR – BEDDINGS

1. Back on the CBS Register, adjust the Forecast T/O Quantity for Backfill Trench to 2300 CY, based
on manual calculations.

2. Open the Backfill Trench Cost Item Record.

3. Add the following resources:
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l LL2 Laborer – 3

l LO2 Operator Class 2 – 1

l RPC Plate Compactor – 1 

l EL950 Loader 950 – 1

4. Adjust the Production to 160 CY/Day.

5. From the Cost Item Record’s Actions tab, select Trench Calculator.

6. Select Load Configuration from Library

7. Select Trench Example (with your initials), then click OK.

8. On the Trench Calculator, select the Beddings tab.

9. On the Beddings tab, you can define up to four beddings to backfill the trench

l The variables you enter will determine how much bedding you need

10. Enter the following variables for each bedding:

Bedding Lift 1 Bedding Lift 2 Bedding Lift 3

Elevation (from trench floor) 6.00 38.00 76.00

Additional material needed 5.00 5.00 5.00

Conversion factor 1.60 1.70 1.60

l Under Results, you can match each of the Bedding Lifts with a material resource, by
selecting the resource icon and selecting the resource you want to employ from the
Material tab

11. Selecting the resource from the Tons selection field, select the following materials for each
bedding:

Resource Code Resource Description

Bedding Lift 1 MASAND Sand

Bedding Lift 2 MAFA Fine Aggregate

Bedding Lift 3 MACA1-1/2 Coarse Aggregate
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12. Click OK.

l Note that the pipe and bedding materials are added to the cost item with their quantities
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EXERCISE 14.1 — TRENCH CALCULATOR

In this exercise, you will practice using the Trench Calculator to take-off piping and bedding
materials. Complete the following steps:

1. In the Training Job, create a new cost item called Underground Pipe.

2. Give the cost item a quantity and unit of measure of 1640 Linear Feet.

3. Open the new cost item and open the Trench Calculator.

4. On the Trench tab, enter the variables for the trench:

Trench length 1000 feet

Trench width (at bottom) 4 feet

Trench depth 10 feet

Hinge elevation 5 feet

Backslope 45 degrees

Material swell/shrinkage factor 0.10 (decimal)

l Do NOT check the box to bring in volume shrinkage.

5. Select theMPR36material resource from the drop-down Results list.

6. On the Beddings tab, enter bedding variables.

Bedding lift 1

Elevation (from trench floor) 6 inches

Additional material needed to compensate for compaction 5.00%

Conversions factor (Ton per CY) 1.3

Bedding material resource (Tons) MASAND
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Bedding lift 2

Elevation (from trench floor) 38 inches

Additional material needed to compensate for compaction 5.00%

Conversions factor (Ton per CY) 1.1

Bedding material resource (Tons) MAFA

Bedding lift 3

Elevation (from trench floor) 76 inches

Additional material needed to compensate for compaction 5.00%

Conversions factor (Ton per CY) 1.1

Bedding material resource (Tons) MACA1-1/2

7. Select OK and confirm that the pipe material and bedding materials populated the cost
item.

You should end up with the following results

Congratulations, you have completed this exercise!
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14 . 3 IN -F IELD CALCULATOR

You can use the In-field Calculator to do simple mathematical calculations in any numeric field on
records, registers, and tree lists. You use this calculator much like an Excel workbook field, by inserting
the cursor in the field where you want to perform a calculation, then pressing the "=" key, followed by
a valid arithmetic expression. To display the calculated result, you press the tab key. The resulting
value is stored without the arithmetic expression used to calculate the value.

The following steps walk through using the In-field Calculator to calculate the area of how much
sandblasting is needed for painting the steel bridge structure specified in the Training Job.

The resulting field value is stored without the arithmetic expression used to calculate the
value.

STEP BY STEP — IN-FIELD CALCULATOR

1. Open the Training Job and from the Estimate tab, select Cost Breakdown Structure.

2. Scroll to find cost item 13.3 Sandblast.

3. Click in the Forecast (T/O) Quantity field.

4. Press the = key, then type 10*250.
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5. Press the Tab key and it calculates the result.
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LESSON 14 REVIEW

1. The Haul calculator allows you to:

a. Calculate the number of trucks required to complete the haul in a set amount of
time

b. Calculate how long it will take to complete the haul with a set number of trucks

c. Neither

d. Both

2. The Trench Calculator allows you to quickly calculate ___________ values.

a. Trench

b. Pipe

c. Bedding

d. All of the above

3. For the in-field calculator, what symbol needs to be at the beginning of the math
equation for it to calculate?

a. +

b. –

c. =

d. (

LESSON 14 SUMMARY

As a result of this lesson, you can:

l Use the Haul Calculator

l Use the Trench Calculator

l Use the In-Field Calculator
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LESSON 15 — ADVANCED PR IC ING

LESSON DURATION: 40 MINUTES

LESSON OBJECTIVES

After completing this lesson, you will be able to:

l Use advanced pricing options including: alarm limits, subtotals, rounding precision, and Fixed
Final Price

l Create and compare alternates for cost items and pay items

l Use Billing Rates



15 . 1 ALARM L IM ITS

The Alarm Limits lets you establish limits to specific pay items to make sure the pricing is within certain
limits, i.e. percentage or unit price. The Alarm Limits do not do any calculations. It informs you if either
of the limit types are outside the range. If outside the limits, the row is then colored red.

For example, when pricing Mobilization, there can be limits as to the amount that can be entered and
how soon to receive payment. In the screen shot below, you can enter up to 10% of the contract price
and receive that amount when 5 or 10% of the work is completed.

Pay Item and Proposal register:

In this case, the limits are between 8 and 10%. The row is colored red to indicate that the Unit Price is
not within the percentage limits.

The screen shot below is the record view for Mobilization.

The following is an example for Steel Reinforcement as a Unit Price range.
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Based on the screen shots, the Unit Price is not within the $1.00 to $1.50 range. It is $1.60.

The record view is now shown.

15 . 2 SUBTOTALS

The subtotal feature is for situations where the Owner wanted subtotals on the proposal form of pay
item groups.

The following screen shot is using the supplied Subtotal register view:
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From the Subtotal column, the last item in the subtotal group is where the box is checked. Once the
box is checked, then a description may be entered. After the box is checked, the Subtotal Amount and
Running Subtotal Amounts are then displayed in a bold font.

In our standard Proposal Report, there is an option to printout the subtotals.
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EXERCISE 15.1 — SUBTOTAL VIEW

Go to the Pay Item & Proposal Subtotal view to view subtotals.

1. In the Training Job, add an additional subtotal on the pricing page of your estimate to
appear after Unclassified Excavation.

2. Add the subtotal with the description "SUBTOTAL: EARTHWORK" in the Pay Item &
Proposal register.

3. Run the Standard Proposal report with subtotals showing.

Congratulations, you have completed this exercise!
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15 . 3 ROUND ING PREC IS ION

Rounding Precision lets you change the decimal position of the Unit Prices instead of manually entering
the values.

You can preset the Unit Price decimals, then using this feature, round up or down the decimals. The
job’s default Unit Price decimal is set to 2.

There are two decimal selections to understand. In the Settings form from the Backstage View,
Decimal Precision lets you to calculate how many decimals to display.

In the Cost Basis form from Job Properties, use the Unit Price decimal to calculate the Total Price.
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In the following screen shot, the Rounding Precision column is set to 2 for each pay item with the
exception of Mobilization, which was changed to -2. The -2means to the nearest $100.

Change the 2 and 3 pay item row's Rounding Precision to 0 and 1. The Unit Price changed accordingly.
In doing so, you are moving the decimal to show tenth, zero, ten dollars, or in the Mobilizations case to
the nearest $100.
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EXERCISE 15.2 — ADVANCED PRICING

SCENARIO: Using the Training Job, do the following to get ready for your bid closeout meeting with
your manger:

1. Set up rounding precision so all prices round to whole numbers (no decimals).

2. Add subtotals based on the owner's specifications.

3. Add an indicator to show if your unit price for Unclassified Excavation goes over
$18/cubic yard.

Congratulations, you have completed this exercise!
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15 . 4 PAYMENT METHODS

There are three different Payment Methods:

l Unit Price
l Fixed Final Pay
l Time and Expense

The Unit Price is the default Payment Method. This option multiplies the Unit Price to the Pay Quantity
to calculate the Total Price.

The Fixed Final Pay method has two applications:

l display contingency type pay items.
l accurately calculate the over/under run pay items that are paid as if they were lump sum
items.

Contingency type pay items is where the owner provided the pay item and entered their own value.
This becomes part of the proposal where it may or may not be used. To identify this type of pay item,
select the Fixed Final Paymethod, as displayed in the following screen shot. Then, enter $10,000 for
example.
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If this were a real pay item, lock the $10,000 because it must be part of the proposal. However, then
the issue is how to account for any costs, overhead, or profit to this Pay Item. Assuming you did not
want to add any overhead and profit dollars to the $10,000, enter a plug source of $10,000 in the CBS.
This offsets the Price of $10,000 but charges the $10,000 to a Cost Category that won't be used in any
overhead of profit dollars. Now, the $10,000 is not markup.

The second application the Fixed Final Pay method has is to accurately calculate the over/under run
pay items that are paid as if they were lump sum items. An issue occurs where a pay item is provided
with a quantity, such as a Superstructure Bridge of 10,000 CY, and you must enter a Unit Price against
the 10,000 CY.

However, the fine print says that this Pay Item can not be measured and can be paid as if it was a Lump
Sum item, but your quantity takeoff convinced you that you use more or less than the 10,000 CY. Say
your takeoff came to 12,000 CY and you entered the Forecast (TO) Quantity with the 12,000 CY.

Now the CBS is calculated on the 12,000 CY. Now normally in an over/run quantity, InEight Estimate
can help you decide how best to price out these items. In this case, you cannot take advantage of this
situation. The system converts that total cost based on the 12,000 CY. However, you divide by the
10,000 CY to give a different Unit Cost in the Pay Item and Proposal form. This way, when you get paid,
you get the cost as developed in the CBS.

The following screen shot shows the situation where you have an overrun normally. In this example,
you developed the CBS direct cost as $4.00 times 12000 CY for $48,000. (the system shows more
accuracy). Notice the direct costs of $40,000 and the balanced unit of $5.51. This is the normal
calculation if this was a true overrun pay item.
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When you change the Payment Method to Fixed Final Pay, the CBS cost of $48,000 is now shown.
Then when you price out the pay item, you get your $48,000 return.

Now for the Time and Expense payment method. This option is used with the Job Tracking form. Each
resource type can enter a Billing rate. For Force Account/Time and Material/Time and Expense work,
by changing the pay item to this method, the actual costs are entered in the Job Tracking form. Then
there is an Excel report that lists the actual costs using the Billing rates, plus the profit entered in the
Job Tracking tab in the Job Properties form.

InEight Inc.  |  Release 24.9 Page 163 of 240

Estimate Intermediate User Guide 15.4 Payment Methods



15.4.0.1 CRITICAL THINKING – FIXED FINAL PRICE

SCENARIO: You are estimating a reinforced concrete bridge job. For the “Superstructure Concrete”
pay item, the owner provides a quantity of 1000 cubic yards, but in the fine print you read “This pay
item will be paid as if it were a lump sum item; there will be no measurement of the cubic yards.”

You have already done the takeoff and measured 1200 cubic yards for the Superstructure Concrete
and estimated the unit cost, but you know, based on the owner’s fine print, you will only get paid
based on the 1000 cubic yards the owner specified, leaving 200 cubic yards on the table that you
won’t get paid for.

If this were a unit price item, normally you would get paid based on your pay item price, by taking
the unit cost from the CBS, adding overhead and profit, then multiplying that unit price by the
quantity. But since this is being treated like a lump sum, you will only get paid based on the 1000
cubic yards instead of the 1200 you measured.

HOW CAN YOU STILL GET PAID BASED ON THE TOTAL COST
YOU DEVELOPED FOR THIS ITEM IN THE CBS?

A. Add more profit to the pay item to cover the loss in cost.

B. Come up with the pay item’s total price, based on the total cost you determined from 1200 cubic
yards, then divide it by the pay quantity (1000 cubic yards) to come up with the unit price.

C. Come up with the pay item’s unit price, then multiply it by the forecast quantity (1200 cubic
yards) to come up with the total price.

View the following page for feedback
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15.4.0.2 CRITICAL THINKING – FIXED FINAL PRICE

FEEDBACK

HOW CAN YOU STILL GET PAID BASED ON THE TOTAL COST YOU
DEVELOPED FOR THIS ITEM IN THE CBS?

A. Add more profit to the pay item to cover the loss in cost.

You could do this, but it would make less profit available for other items.

B. Come up with the pay item’s total price, based on the total cost you determined from 1200 cubic
yards, then divide it by the pay quantity (1000 cubic yards) to come up with the unit price.

This is a great approach. This ensures you account for all the cost you came up with in the CBS.
When you divide it by the pay quantity, you will have a higher unit price that covers the
overruning quantity you measured.

C. Come up with the pay item’s unit price, then multiply it by the forecast quantity (1200 cubic
yards) to come up with the total price.

This is exactly what would occur if this were a normal unit price item and the owner had agreed
to pay you based on the measured quantity. Since the owner is treating this like a lump sun, you
will only get paid based on 1000 cubic yards and miss out on 200 cubic yards' worth of cost.
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15 . 5 UNBALANCED PR IC ING

The pay items are provided along with the Pay Quantities. If the pay items are to be measured and
paid on the final measured quantity, then we can provide information to price the pay items to
maximize the return. Some specifications are written that if an over/under pay item runs a certain
percent, then the Unit Price is negotiated. Now, understanding this,you can forecast the final revenue
result.

The following screen shot shows a typical over and under run situation. The overrun quantities are
shown in green and the underrun is shown in red. I have balanced priced the job where all pay items
are using their Balanced Unit Price. In the Variance box, the Profit row, there is an ADD of $4153
dollars.

This means that if your Forecast Quantities become the final measure amount, I lose the $4153 dollars.
This is the difference between the Target Profit and the Forecast Profit. The issue is the underrun
quantity is priced at its Balanced Price, meaning there is 3000 Ton that I will not be paid for if my
35000 Ton is what I am expecting.

Now, I will use the system’s Unbalanced feature to price all the pay items. See the following screen
shot.
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What the Unbalanced Autoprice did was to price out the underrun with it’s Direct Cost only. The
overhead and profit share of the underrun was spread proportionately to the overrun items. The
underrun was priced lower than normal and the Overrun items were price higher than normal.

Now look at the Variance block and see the Profit row where it now says CUT, meaning if my forecast
quantities in up being the final measured quantities, I will pick up an additional $61,723 dollars in
profit.

The CUT simple allows you to decide if you want to keep the final Proposal price as shown, or to CUT
the $61,000 OR ANY PORTION of it from the final Proposal amount to get the job believing your
Forecast Quantities is the final measured quantities. Of course you can enter any preferred Unit Price.

15 . 6 B ID PR IC ING US ING B ILL ING RATES

For Cost Reimbursable or time and expense type projects it might be necessary to produce a bid
proposal based on the billing rates used in the estimate. Choose to price your bid items in the job using
a target price based on either charge rates or billing rates plus a distribution of unassigned costs and
markup.
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15 . 7 EARN INGS RULES

The Earnings Rules let you decide how much can be paid where certain work is completed. The cost
items assigned to the pay items are where you can decide when to ask for payment.

The application is used in the Job Tracking form. The Earnings Rules also determine how the Cash Flow
curve is generated.

In the following screen shot, the record for 36 inch RCP Culvert Class III from the Training Job is open.
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By default, the cost items in the Earnings % column are calculated based on the cost distribution. In
this case where all the Materials are furnished and completed the Excavatzion, you have earned $49.58
and $12.12 for a total of 61.7% revenue.

There may be times when you can only receive revenue when you have only completed the Backfill of
the Pipe. In that case I can uncheck the Use Default Earnings Rules box, as seen in the previous screen
shot, and enter 100%. You can then decide when to account for the revenue by changing the Earnings
Timing.

The following screen shot show this option.
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Another example is when you can get full payment for material on hand, such as Precast Girders. Then
you can choose the start for the Earnings Timing. This way, the Cash Flow shows costs and revenue
occurring at the start of the item.
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15 . 8 ALTERNATE SCENAR IOS

The Alternate scenarios feature allows a contractor to effectively evaluate multiple approaches to an
estimate, and quickly identify the most cost efficient way of performing the proposed work. Both
owners and contractors need more visibility to see the impact of changes made to the assumption
made on the cost model.

For example, a contractor might want to estimate the cost of hauling excavation material using a
scraper hauling machine(s). Alternatively, a contractor may want to compare the cost of loading and
hauling that same excavation material with a loader truck(s). You should be able to estimate both
approaches quickly and switch between various scenarios.

Owners are increasingly requiring contractors to provide alternative items within the bid proposal.
Contractors should consider the cost impact of alternative estimate approaches, while also
contemplating how to effectively price their work.

The primary purpose for using Alternate Scenarios is to create ‘What If’ type of scenarios to gain a
better view of estimating ‘like’ situations. By defining Alternates, you have the ability to compare
multiple scenarios within an estimate, in which you can suspend or unsuspend various records.

Manually suspending and unsuspending items can be time consuming and error prone,
and can require maintenance of several versions of the estimate. Creating Alternate
Scenarios is a solution to this problem.

15 .8 .1 BASE ALTERNATE

Base Alternate refers to your base or anchor estimate and is part of the estimate’s cost.
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15 .8 .2 ALTERNATES RECORDS

Alternate records are used to define alternate scenarios so that you can assess the impact of those
scenarios.

To access the Alternates form select the Estimate tab. Under the Alternates section, select Alternates.

This action opens up the Alternate Record Details form.

Names Description

1. Code Code of Alternate Scenario.

2. Description Description of Alternate Scenario.

3. Active Determines if Alternate Scenario is active
within CBS or not.

4. Total Cost
(Added)

When Alternate is set to active, it will not be
suspended, and its CBS Total Cost will be
added to the estimate’s Total Cost Forecast.
Below example shows the full $84,000 will be
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Names Description

included in the estimate.

5. Total Cost
(Suspended)

When Alternate is set to active, Total Cost
Suspended will be $0 because alternate is
active part of bid.

6. Total Cost (Net
Change)

Difference between Total Cost Added and
Total Cost Suspended.

15 .8 .3 ALTERNATES RECORD DETAILS

Drill down into an Alternate Record to view and edit its attributes. The Alternate Record details form
provides you with a way to setup rules for auto suspending and unsuspending groups of cost items.
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Names Description

1. Assigned to
Alternate

Code of Alternate Scenario.

2. Suspended by
Alternate

Description of Alternate Scenario.

STEP BY STEP — CREATE ALTERNATE SCENARIO IN CBS

1. From the Ribbon, select the Estimate tab.

2. Select Cost Breakdown Structure (CBS). The Cost Breakdown Structure (CBS) Register opens.

3. Using the Unclassified Excavation cost item, type in Rock Excavation as a new subordinate.

4. Then type in 3000 in the Forecast T/O Quantity column.

5. Under the Unit of Measure column, select Cubic Yard.
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6. Double click the Rock Excavation cost item to open the cost item's record.

7. Select the Plug tab. Under the Subcontract section click into the Unit Cost field for the
Subcontract Price.

8. Type $28.00 in the Plug Unit Cost column for the Subcontract Price. Once done, click OK.

9. On the CBS Register, change your Saved Views to Alternates View.

10. Select the Rock Excavation cost item. Under the Alternate column, select the drop down arrow,
and then select the Add icon. This will open up a new form to create a new Alternate record.
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11. Type ROCK1 in the Code field, and type Rock Excavation in the Description field. Once done, click
OK.

12. An Attention message will appear alerting you the item will be suspended once you move off the
field.

13. Select Yes. You see the Rock Excavation item is now in suspended status.
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Suspended status is the default status for alternate items.

14. In order to activate this alternate item, select the Estimate tab in the Ribbon and go the
Alternate Scenario drop down in the Alternates section.

15. Then select the ROCK1 scenario. Once done, click OK. The Suspend check box fields is no longer
checked for Rock Excavation.

Alternate Scenario’s BASE and ROCK1 are now both included in the Total Cost
Forecast in your estimate. This is also known as additive type of alternate, meaning
that when it’s active it will be added to the estimate. When Alternate Scenario Base
+ ROCK1 are both checked, the cost item assigned to the ROCK1 alternate is
included in the Total Cost (Forecast).

InEight Inc.  |  Release 24.9 Page 177 of 240

Estimate Intermediate User Guide 15.8 Alternate Scenarios



16. When only the Base Alternate Scenario is checked, the cost item assigned to the ROCK1
alternate is NOT included in the Total Cost (Forecast). Only base alternates are including the
estimate’s cost.

When a cost item is assigned to an alternate, it’s then considered an alternate item
in the estimate and does not contribute to the job’s cost until the alternate is
‘activated’.

15 .8 .4 ASSIGNING MULTIPLE COST ITEMS TO ONE
ALTERNATE

Any number of cost items can be assigned to a single alternate item. The alternate feature can be used
to quickly suspend and unsuspend groups of items. Another manner in which alternates can be used
would be to consider two different approaches to completing the same scope of work. In this case the
activation of an alternate would replace the preselected cost items.

Imagine you are a contractor and want to assign an Alternate Scenario to your 3.2 Excavation Trucks
cost item, and at the same time automatically suspend your 3.1 Excavation Scrapers cost item. You
need an Alternate Scenario view showing what would happen when you suspend Excavation Scrapers,
but want to keep your Excavation Trucks active. You’d like to evaluate this pricing scenario, especially
your Total Cost Forecast.
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STEP BY STEP — MULTIPLE COST ITEMS TO AN ALTERNATE

1. From the Ribbon, select the Estimate tab.

2. Select Cost Breakdown Structure (CBS). The Cost Breakdown Structure (CBS) Register opens.

3. Create a copy of cost item Excavation and rename it Excavation, scrapers.

4. Rename the original Excavation cost item to Excavation, trucks.

5. Under the Unit of Measure column, select Cubic Yard.

6. Double click to open the cost item Excavation, trucks.

7. Add a new Construction Equipment Resource: code ETDT Dump Truck, then select OK.

8. Add a new Construction Equipment Resource: code EL950 Loader 950, select OK.

9. Change the quantity of ETDT Dump Truck to 5.

10. Add a new Labor Resource: code LT1 Teamster, then select OK.

11. Change the quantity for LT1 Teamster to 5.

12. Remove resources ES621 Scraper 621, ES623 Scraper 623, L01 Operator Class 1.

13. Change the quantity for L02 Operator Class to 5.

14. Change the Cubic Yard/Day to 2800 on the Production tab.

15. Your results should look like this:
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16. The Unit and Total Cost are now recalculated. Once you are done with all your changes, click OK
to return to the CBS register.

17. Your Excavation, truck cost item is now worth $3.59 a Cubic Yard, while your Excavation, scraper
cost item is worth $3.00 a Cubic Yard.

In order to make these two cost items mutually exclusive, meaning that you want
one or the other in the bid, you can set this up via an alternate item. You can set
this up so that one is automatically suspended, while the other is active
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18. For Excavation, truck, add a new Alternate by click on the Alternate field and selecting the new
icon.

19. Type ROCK2 in the Code.

20. Type in Trucking Excavation for the description.

21. Click on the Cost Items tab. In the CBS Position Code field, select the Excavation, scrapers.
Excavation, scrapers will now be suspended when Alternate Excavation, trucks is active.

22. An Attention message will appear alerting you the item will be suspended once you move off the
field. Select Yes to continue. On the CBS Register, you now see that Excavation, trucks is
suspended while Excavation, scrapers is activated.
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23. In order to activate this alternate item, select the Estimate tab in the Ribbon and go the
Alternate Scenario drop down in the Alternates section.

24. Then select the ROCK2 scenario. Once done, click OK.
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25. The trucks cost item is now active and scrapers has automatically been suspended. Now the
Suspended by Alternate column is checked for cost item Excavation, trucks.

InEight Inc.  |  Release 24.9 Page 183 of 240

Estimate Intermediate User Guide 15.8 Alternate Scenarios



15.8.4.1 CRITICAL THINKING – ALTERNATE SCENARIO (OWNER)

SCENARIO: Carla, an estimator at Genco Power is developing an estimate for upcoming maintenance
work at one of Genco’s power plants. She wants to explore two different options for removing and
replacing a feed water system.

In one approach, she assumes that crews will be able to increase access to the work area by cutting
a large access way through the wall of the metal building. This would allow for easier access to the
feed water system that needs replacing. Parts and materials could be staged nearby outdoors and
hoisted into position as they’re needed. Also, crews would be able to access the work area more
readily, streamlining operations.

She also uses another approach, in which Engineering won’t approve plans for increased access by
cutting through the building’s wall. In this case, the replacement of the feed water system will be
more tedious, as workers will need to wind their way through existing plant infrastructure to access
the area in which they will be working. This has a pronounced effect on the crews’ productivity and
their ability to transport and stage materials to the area where the work will be performed.

WHICH OF THE FOLLOWING WOULD BE THE BEST WAY FOR
CARLA TO ESTIMATE BOTH OPTIONS IN INEIGHT ESTIMATE?

A. Create cost items for both options and use the Suspend feature to toggle between them.

B. Use the Snapshot feature to create a second version of the estimate with the second option
estimated. You can compare the original estimate to the snapshot copy of the estimate
containing the alternate option.

C. Create the second option in the same estimate and assign different alternate scenario records to
each option respectively. Control whether the pay item is included using the Alternate Scenario
drop-down.

View the following page for feedback.
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15.8.4.2 CRITICAL THINKING – ALTERNATE SCENARIO (OWNER)

FEEDBACK

WHICH OF THE FOLLOWING WOULD BE THE BEST WAY FOR CARLA TO
ESTIMATE BOTH OPTIONS IN INEIGHT ESTIMATE?

A. Create cost items for both options and use the Suspend feature to toggle between them.

Suspending cost items removes it from the estimate effectively, but this process is more
cumbersome, since you have to suspend each item manually and re- price each time.

B. Use the Snapshot feature to create a second version of the estimate with the second option
estimated. You can compare the original estimate to the snapshot copy of the estimate
containing the alternate option.

This gives you nice visibility of the two versions of the estimate side by side but is a bit laborious
to develop and manage.

C. Create the second option in the same estimate and assign different alternate scenario records to
each option respectively. Control whether the pay item is included using the Alternate Scenario
drop-down.

This is the most efficient approach. The Alternate Scenarios drop-down makes it easy to select
and de-select alternates, with a few clicks.
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15.8.4.3 CRITICAL THINKING – ALTERNATE SCENARIO (CONTRACTOR)

SCENARIO: James, an estimator at ADOT, is about to send a project he estimated out for proposal
when he receives word from the environmental technician that the site being developed includes
contaminated soil. He decides to include “Removal of contaminated soil” as an alternate to see if he
can get the cost covered by the contractor.

YOU ARE THE CONTRACTOR SEEKING TO WIN THE
CONTRACT. WHICH OF THE FOLLOWING WOULD BE THE BEST
OPTION FOR DEVELOPING AN ALTERNATE ESTIMATE FOR
THE CONTAMINATED SOIL?

A. Add the “Removal of contaminated soil” pay item, then estimate the contaminated soil in the
CBS and assign it to the pay item. Use the Suspend feature to toggle the pay item on and off,
repricing the estimate each time.

B. Use the Snapshot feature to create a second version of the estimate with the “Removal of
contaminated soil” pay item and estimate included. You can compare the original estimate to
the snapshot copy of the estimate containing the alternate.

C. Add the “Removal of contaminated soil” pay item, then estimate the contaminated soil in the
CBS and assign it to the pay item. Control whether the pay item is included using the Alternate
Scenario drop-down.

View the following page for feedback.
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15.8.4.4 CRITICAL THINKING – ALTERNATE SCENARIO (CONTRACTOR)

FEEDBACK

WHICH OF THE FOLLOWING WOULD BE THE BEST OPTION FOR
DEVELOPING AN ALTERNATE ESTIMATE FOR THE CONTAMINATED
SOIL?

A. Add the “Removal of contaminated soil” pay item, then estimate the contaminated soil in the
CBS and assign it to the pay item. Use the Suspend feature to toggle the pay item on and off,
repricing the estimate each time.

Suspending the pay item removes it from the estimate effectively, but this process is more
cumbersome, since you have to suspend each item manually and reprice each time.

B. Use the Snapshot feature to create a second version of the estimate with the “Removal of
contaminated soil” pay item and estimate included. You can compare the original estimate to
the snapshot copy of the estimate containing the alternate.

This gives you nice visibility of the two versions of the estimate side by side but is a bit laborious
to develop and manage.

C. Add the “Removal of contaminated soil” pay item, then estimate the contaminated soil in the
CBS and assign it to the pay item. Control whether the pay item is included using the Alternate
Scenario drop-down.

This is the most efficient approach. The Alternate Scenarios drop-down makes it easy to select
and deselect alternates, and the pricing updates automatically. This is the easiest way to toggle
between scenarios with a few clicks.
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EXERCISE 15.3 — ALTERNATE SCENARIO

SCENARIO: You are a contractor estimating a job for the owner, DECK Corp. Along with the base
items of the proposal, DECK Corp has decided to include a security guard toll booth as an alternate
item in the award of the contract as well.

The request for the alternate, as indicated below, is more of a “would like to have”, to give DECK
Corp the option if it falls within their budget.

l Using the Training Job, create an alternate scenario for the Toll Both.

l Assign the alternate scenario to your Toll Booth cost items.

l Assign the alternate scenario to your Toll Booth pay item.

l Establish pricing for your Toll Both alternative scenarios.

Congratulations, you have completed this exercise!
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15 . 9 PAY ITEM ALTERNATES

An Alternate Scenario is a set of active Alternates that can also be used with Pay Items. It’s reasonable
for the owner to include pay items as alternates within a job. The owner will most likely base the bid
selection criteria primarily on the base bid items, but may also include alternate items in addition.

The contractor will want to understand the cost impact of an alternate if it is awarded. Contractors
may not know ahead of time which combination of alternates an owner may choose to award. This
feature will help the contactor understand how to spread markup to various bid item prices using
different scenarios. This permits easy comparisons between different scenarios.

Imagine you are a contractor and bidding a job where the owner has included a security guard booth
pay item as an alternate item in the job. The owner bases the base bid selection criteria on the base
bid items, however, the owner elects to include alternate items in the award of the contract too. You
as the contractor need to add the new security guard toll booth pay item to analyze the cost impact of
adding this alternate, among other scenarios.

Suspending an item is the same as ‘Deducting’ an item.

The owner’s bid could look like this below, where the first eight pay items are base pay items. The last
Toll Booth pay item is the owner’s Alternate. All items the owner is requesting to see in the
contractor’s bid.

The one Alternate Construction item below represents a bid item the owner would like to have as part
of the bid as well. However, this one alternate is more of a ‘would like to have’. The Alternate item(s)
help to give the owner the option to accept the Alternates if it still falls within the owner’s budget.
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STEP BY STEP — CREATE PAY ITEM AND PROPOSAL ALTERNATE
SCENARIO

1. From the Ribbon, select the Price tab.

2. Under the Pay Items section, select Pay Item & Proposal. The Pay Item & Proposal Register
opens.

3. Select the Saved Views drop down arrow and select Alternates View.

Page 190 of 240 InEight Inc.  |  Release 24.9

15.9 Pay Item Alternates Estimate Intermediate User Guide



4. At the bottom of the register, create a new pay item labeled as Security Guard Booth in the
Description field. Then in the Pay Item Number field, type in SG1.
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5. Now create a new Alternate for the Security Guard Booth pay item using the same steps for your
new cost item.

6. Click in the Alternates field for the Security Guard Booth Alternate. Select the add icon. An
Alternate Record opens.

7. In the Code field, type in code ALT3.

8. In the Description field type in Security Guard Booth Alternate.

9. Go into the CBS and copy all of the subordinate cost items for the existing Toll Booth cost item.
(We will assume the same Toll Booth resources are needed for a Security Guard Booth).

10. Paste the copied cost items into the new Security Guard Booth cost item you just created in the
PIP.
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11. The cost items have all been automatically suspended in the CBS. This is because the Security
Guard Booth pay item is suspended as well

12. In the Pay Item & Proposal Register, activate alternate pay item Security Guard Booth by
selecting Alternate Scenario Base + ALT3 at that top of the form.
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13. The Security Guard Booth is now activated. You can now see that all of the pay items have been
priced including the Security Guard Booth Alternate pay item.

You may need to establish your pay item price first if a price does not yet exist

14. From the register, select the Actions tab. Then under the Auto Price section, select the Balance
Bid drop down.

15. Select the option Hit Target Goal in order to auto price the job. Now all of the pay items have
been priced, including the Security Guard Booth Alternate pay item.
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15 .9 .1 COMPARE ALTERNATE SCENARIOS

You can price and analyze the impact of each Alternate Scenario to the estimate’s Total Price on the
Pay Item & Proposal Register. This is after the Alternate Scenarios have been defined, assigned, and
activated.

Each Alternate and combination of Alternates represents a different scenario, and prices need to be
established for every scenario that you want to compare.

For example, if you have defined Alternate Scenarios 1, 2 and 3, you may wish to price each of them
separately, and price any combination of them, and/or you may wish to price the combination of all
three.

Be sure to establish bid prices for every alternate or combination of alternates.

STEP BY STEP — COMPARE ALTERNATE SCENARIOS

1. From the Ribbon, select the Price tab.

2. Under the Pay Items section, select Pay Item & Proposal. The Pay Item & Proposal Register
opens.

3. On the Pay Item & Proposal Register, select the Actions tab. Under the View section, select
Compare Alternative Scenarios. This action performs a comparison among the various
Alternative Scenarios you’ve priced so far.

4. After selecting Compare Alternative Scenarios, new columns appear on the pay item form. These
columns show a comparison of the base bid, plus Alternate Scenarios that have been priced so
far.
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5. The current scenario base price Total Price is $6,307,253.15, however the Alternate Price
scenario for the additional Security Guard Booth is $6,337,826.19
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EXERCISE 15.4 — ALTERNATE SCENARIO

SCENARIO: You are a contractor estimating a job for the owner, DECK Corp. Along with the base
items of the proposal, DECK Corp has decided to include a security guard toll booth as an alternate
item in the award of the contract as well.

The request for the alternate, as indicated below, is more of a “would like to have”, to give DECK
Corp the option if it falls within their budget.

l Using the Training Job, create an alternate scenario for the Toll Both.

l Assign the alternate scenario to your Toll Booth cost items.

l Assign the alternate scenario to your Toll Booth pay item.

l Establish pricing for your Toll Both alternative scenarios.

Congratulations, you have completed this exercise!
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15 . 10 B I LL ING RATES

In Estimate, the Billing Rate is defined as how much the Contractor is charging your client to utilize one
of your resources within the Resource Rate Register. The billing rate can also be viewed as how much
money that your client is expected to pay for utilizing one of the resources for a specified amount of
time. It’s important for you as a contractor to have a way to more quickly see your charge rate to
compare against what you will ultimately bill your client, also known as your Billing Rate.

Contractors need a reliable way to price projects utilizing various markup strategies with clear visibility
into various costs that drive the markup amounts. It’s important for contractors to be able to:

l Apply various costs that drive markups
l Apply billing rate gains (difference between contractor’s cost vs billing rates/client cost)
l Have clear visibility into the true margin based on both cost and billing rates
l Compare the cost and billing rates within the CBS

As a result of properly pricing projects, contractors can now create and view various Billing Rate
Reports showing:

l A summary of billing rates in lieu of the cost rates for a client to see, Estimate Summary
reports

l Cost item breakdown that shows associated cost categories, billing unit rates, and total
billing amounts, Billing Rate Summary

l An analysis of reources and their margins, utilization counts and billing amounts, Margin
Analysis report

15 .10 .1 CHARGE RATE

The Charge Rate is the contractor’s cost for a resource. These costs include actual labor, any types of
fringes, labor taxes plus insurances, and more. These costs are all tracked within the Charge Rate’s Cost
Category Breakdown in a resource rate. The charge rate is not a cost to the client and does not include
any profit, markup or overhead. Charge Rates can be setup for a resource by going to the Setup tab
and selecting Resource Rates. Then opening a resource rate record, and selecting the Charge Rate tab.
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15 .10 .2 B ILL ING RATES SETUP

Billing Rates have 3 scales where you can determine the appropriate billing and markups rates.

l Scale 1 – regular time
l Scale 2 – overtime
l Scale 3 – double time

You can enter a billing rate markup as a dollar amount in the Billing Rate Markup field or as a
percentage in the Billing Rate Markup % field. After double clicking a resource rate, you will see the
resource record.
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The Billing Rate tab includes the following fields.

Name Description

1. Charge Rate The amount of money it costs a contractor to
occupy a resource. Also known as the
contractor’s cost.

2. Billing Rate The amount a contractor charges a client to
utilize a resource rate. The billing rate can
also be viewed as how much money the client
is expected to pay for utilizing one of those
resources for a specified amount of time.

3. Billing Rate
Markup

The dollar value amount of profit added to the
charge rate that a contractor generally
determines. This can include certain
contractor fees that the contractor has
deemed to include.

4. Billing Rate The percent dollar value amount of profit
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Name Description

Markup % added to the charge rate that a contractor
generally determines. This can include
certain contractor fees that the contractor has
deemed to include.

The below example shows a contractor’s Charge Rate of $27.48 in Scale 1. The Billing Rate Markup is
45% of the $27.48 Charge Rate, which is a $12.37 Billing Rate Markup. The total Billing Rate is $39.84,
which is the price the contactor would charge a client.

STEP BY STEP — BILLING RATE SETUP

1. Use the Training Job for this example. From the Ribbon, select the Setup tab.

2. Under the Resources tab, select the Resource Rates drop down arrow. Then select Labor. The
Resource Rate Register opens to the Labor tab.
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3. Select the LW WELDERDWelder Resource Code from the list. Then select the Actions tab. Under
the Edit section, select Open.

4. After the Labor Rate Record opens, select the Billing Rate tab.

5. Change the Billing Rate Markup % to 15 for Scale 1, then tab out of the field.

l The system automatically calculates the Billing Rate Markup field to $6.38.
l This represents 15% of the Charge Rate.
l The Billing Rate is now equal to the Charge Rate plus 15%.
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6. Change the Billing Rate Markup to $14.68 for Scale 2.

l The Billing Rate Markup % is now 23% and the Billing Rate is now $78.51.
l Scale 1 Charge Rate of $42.56 plus (half of $42.56) $21.28 equals a Scale 2 rate of
$63.83.

l Scale 2 rate of $63.83 plus 23% equals a billing rate of $78.51

15 .10 .3 COST VS. B ILL ING VIEW

The Detail tab in a Cost Item record lets you compare the Unit Cost (charge rate) against the client’s
Billing Unit Rate.

To view the Cost vs. Billing View within a Cost Item record, select a cost item record, click on the Detail
tab, then select the Billing Rates View.

The Detail tab includes the following fields.
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Name Description

1. Unit Cost This is the contractor’s cost for this resource
rate, also known as the Charge Rate.

2. Billing Unit Rate The amount a contractor charges a client to
utilize a resource rate, also known as the
Billing Rate.

3. Total Cost
(Forecast)

This is the Unit Cost multiplied by the number
of hours utilized.

4. Total Billing
Amount

This is the Billing Unit Rate multiplied by the
number of hours utilized.

l Below is an example of how to view the Cost vs. Billing View when the Production Days
are equal to 1.

l The Unit Cost (Charge Rate) and the Billing Unit Rate values both values derive from your
Resource Rate.

STEP BY STEP — CBS COST VS. BILLING VIEW

1. From the Ribbon, select the Estimate tab.

2. Select Cost Breakdown Structure (CBS). The Cost Breakdown Structure (CBS) Register opens.

3. Create a cost item called Fabrication Work. Double click on the new cost item to open it.

4. Select the Detail tab. Then select LWD Welder from the Code field.
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5. Go to the Production default data block. In the Days field, enter in 1.

6. You are now able to compare your Total Cost against the Billing Rate. Your Total Cost is $226.96
for 8 hours, while you Total Billing rate to the client is $317.74.
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15 .10 .4 B ILL ING RATE REPORTS

There are several reports you can run to view resource costs, billing rates, and mark-ups. Some of
these reports you may choose to provide to your customer. Other reports, you may choose to use only
as a way to view your markup margins prior to submitting to your customer.

To locate these reports, select the Setup tab. Then select Reports. From the Reports window, select
Billing Rate Reports.

15.10.4 .1 BILLING RATE SUMMARY REPORT

The Billing Rate Summary report shows cost items including cost category details.

The end of the report shows you a total of your Direct and Indirect cost markups, and also includes a
Total Billing Amount at the bottom far right.

15.10.4 .2 ESTIMATE DETAILS WITH BILLING RATE REPORT

The Estimate Details with Billing Rate report shows a selection of resources with associated billing rates
and utilization counts.
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15.10.4 .3 MARGIN ANALYSIS REPORT

The Margin Analysis report is beneficial for displaying both mark-up and margin values for selected
resource rates.
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EXERCISE 15.5 — BILLING RATES

SCENARIO: You are an estimator working for Hexco Civil, and your company has started work on the
excavation and grading portion of a project for Health Choice hospital campus.

During this phase, the crew runs into underground storage tanks that have contaminated the soil.

Robert, the Health Choice engineer, requests “rather than detail out an estimate, we’ll just do a time
and materials agreement for this portion.”

You agree on a 20% markup on your going rates for labor and equipment.

IN THE TRAINING JOB:

1. Make a copy of the Training Job.

2. In the new job, apply billing rates to the resources employed on the subordinates of the
“Removal of Underground Storage Tanks” and “Disposal of Contaminated Soil” cost
items.

3. In the PBS, select the Charge Rate and Billing rate Saved View to compare your rates.

4. In Job Properties > Pricing, change the setting to Calculate Balanced Pay Item Prices using
Billing Amount.

5. In the Pay Item & Proposal Register, note that your Target Price is now based on billing
rates.

6. Decide if you want to spread any addition overhead or profit to your “Removal of
Underground Storage Tanks” and “Disposal of Contaminated Soil” pay items (or just leave
them with their current billing rates.

Congratulations, you have completed this exercise!
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15 . 11 B I LL ING RATES REPORTS OVERV IEW

15 .11 .1 COST ITEM SUMMARY

The Cost Item Summary tab in a Cost Item Record, allows the estimator to add additional costs to the
Resource Billing rates by a percentage or amount. For example, there may have been extra work that a
percentage would apply that the owner approves. The Billing reports then lists these for the owner.

The following screen shot shows cost item 3.1 with the adjustment. To see the adjustment, select the
Actions tab and under the View section, use the Display Billing Rate toggle to display the Billing Rate
columns.

Review the two columns Total Billing Amount and Unadjusted Total Billing Amount.

The following screen shot is the estimate details with Billing Rates report for the 3.1 cost item.
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15 .11 .2 DEPENDENT COST ITEMS

You can use dependent cost items with billing work. For example, the Contractor may have an
agreement with the Owner to add additional overhead costs as a percentage of the work or the Owner
allows a contingency for unknown work.

The following screen shot is an example of using a dependent cost item with billing work.
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The following screen shot is a sample report that includes the dependent cost item with billing work.
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15 .11 .3 ADDIT IONAL MARKUP IN THE PBS FORM

Depending how the Resource Billing Rates are determined, to accommodate the Owner, a fee can be
applied using the PBS form.

The screen shot is a sample markup for Direct Costs in the PBS form.

The following screen shot is of a sample report that includes that fee total of the additional markup.
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LESSON 15 REVIEW

1. In what form do you apply sub totals, fixed final price, and rounding precision?

a. Pay Item & Proposal Register

b. Cost Breakdown Structure Register

c. Job Properties

d. Price Breakdown Structure

2. Where do you go to activate an Alternate scenario?

a. Customize section of the System tab

b. Initialize section of the Setup tab

c. Overhead and Profit section of the Estimate or Price tab

d. Alternates section of the Estimate or Price tab

3. Where do you go to set pay items to be based on billing rates?

a. Pay Item & Proposal Register

b. Cost Breakdown Structure Register

c. Job Properties

d. Foundation Setup Data

LESSON 15 SUMMARY

As a result of this lesson, you can:

l Use advanced pricing options including: alarm limits, subtotals, rounding precision, and Fixed
Final Price

l Create and compare alternates for cost items and pay items

l Use Billing Rates
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LESSON 16 — BENCHMARK ING

LESSON DURATION: 40 MINUTES

LESSON OBJECTIVES

After completing this lesson, you will be able to:

l Set up and use benchmarking to compare your job to past projects



16 . 1 BENCHMARK ING OVERV IEW

Benchmarking is used to validate an estimate's cost and productivity values by comparing them to
relevant historical data, specifically as-built and as-estimated information captured from past jobs in
Estimate. Unit cost and unit man-hour benchmark data points are displayed graphically in relation to
the current estimate.

When using the Estimate in the Cloud benchmarking feature, it requires the installation
of Connected Analytics.

16 .1 .1 BENCHMARKING MASTER JOB PROPERTIES
FORM

TheMaster Job Properties - Benchmarking form is used to establish the historical data to be used for
benchmarking the current job, and to define the default benchmark graph display and calculations.

TheMaster Job Properties - Benchmarking form includes:

l Historical Data Source - Select As-Estimated and As-Built data from the Data
Warehouse.

l Default Cost Item Matching Criteria, Default Account Code Matching Criteria and
Default Jobs Filter - Define which cost items, account codes and jobs should be included.

l Benchmark Graph display Options - Define the data to be represented on both the X-
Axis and the Y-Axis of the graph.

l Calculate "Average" as- Define the calculation method as either Average or Weighted
Avg (weighted by current Qty).

l Benchmark - Select a benchmark value of Cost per Unit, Man-Hours / Unit, or Units /
Man-Hour.

l Flag an item's variance relative to the benchmark data when - Define the breakpoints for
low, medium and high variance ranges.

l Don't benchmark items with fewer than <number> historical data points - Designate the
minimum number of data points needed to benchmark an item.

The data in the Master Job Properties - Benchmarking form is automatically copied to any
newly created jobs. If all of the jobs that you create in Estimate will use the same rules,
defining the data in the Master Job Properties form will save time when you create new
job folders in Estimate.
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In addition to the primary Forecast (T/O) Quantity and Unit of Measure on each cost item, Secondary
Quantity and Secondary Unit fields in the Cost Item Record can be used to capture a meaningful,
alternative quantity and unit on which to analyze As-estimated data.

You can establish the historical data to be used for benchmarking the current job, define the default
benchmark graph display, and define high, low and medium variance ranges on the Job Properties -
Benchmarking form.

STEP BY STEP — BENCHMARKING MASTER JOB PROPERTIES FORM

1. From the Backstage View, select Library from the left pane navigation.

2. From the Ribbon, select the Setup tab. Under the section Master Initialization, select Job
Properties. The Job Properties register opens.

3. On the Job Properties form, select the Benchmarking tab.

4. The Historical Data Source defaults to Data Warehouse. Select the historical data to use: As-
Estimated, As-Built, or both.

5. To define Default Cost Item Matching Criteria, click the Edit button and define your criteria for
matching cost items. You can select one or many fields and relate them using AND/OR logic.

6. To define Default Account Code Matching Criteria, click the Edit button and define your criteria
for matching cost items. You can select one or many fields and relate them using AND/OR logic.

A matching benchmark data point will be excluded if its unit of measure type (e.g.,
area, length, etc.) is different than the unit of measure type of the matching item in
the current estimate.

7. To filter the jobs to include, click the Edit button on the Default Jobs Filter and define your job
filtering criteria.

8. Choose your Benchmark Graph Display Options:

l Select the data to be represented on the X-Axis:
o Date
o Item Quantity (Primary)
o Item Quantity (Secondary)
o Ratio (Primary / Secondary)
o Ratio (Secondary / Primary)
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l Select the data to be represented on the Y-Axis:
o $ / Primary Unit
o Man-Hrs / Primary Unit
o Primary Units / Man-hr
o $ / Secondary Unit
o Man-Hrs / Secondary Unit
o Secondary Units / Man-hr

9. Define your average calculation method as either Average orWeighted Avg (weighted by
current Qty).

10. Define the Benchmark values that will be calculated from the historical data set by selecting Cost
per Unit,Man-Hours / Unit and Units / Man-Hour.

11. Define the variance ranges to be used for flagging an item relative to the benchmark data:

l To flag an item's variance from the average, select Its % variance from the average
exceeds and choose the Low, Medium, and High percentages to flag (values are
incremented by 1%).

l To flag an item's standard deviations from the norm, select Its standard deviations
from the norm (using SSTDEVP method) exceeds and choose the Low, Medium
and High values to flag (values are incremented by .1).

12. To customize the display colors for the Low,Medium and High ranges, click on a color block and
choose a different color.

13. To set a minimum number of benchmark data points required for an item to be benchmarked,
select a number in the Don't benchmark items with fewer than historical data points field.

NOTE: The data in the Master Job Properties form is automatically copied to any
newly created jobs. If all of the jobs that you create in Estimate will use the same
data, descriptive information and rules, defining the data in the Master Job
Properties form will save time when you create new job folders in Estimate.
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16 .1 .2 BENCHMARKING JOB PROPERTIES FORM

The Job Properties - Benchmarking form is used to establish the historical data to be used for
benchmarking the job, and to define the default benchmark graph display and calculations.

The Job Properties - Benchmarking form includes:

l Historical Data Source - Select As-Estimated and As-Built data from the Data Warehouse.
l Default Cost Item Matching Criteria, Default Account Code Matching Criteria and Default
Jobs Filter - Define which cost items and which jobs should be included.

l Benchmark Graph display Options - Define the data to be represented on both the X-Axis
and the Y-Axis of the graph.

l Calculate "Average" as- Define the calculation method as either Average or Weighted Avg
(weighted by current Qty).

l Benchmark - Select a benchmark value of Cost per Unit, Man-Hours / Unit, or Units / Man-
Hour.

l Flag an item's variance relative to the benchmark data when - Define the breakpoints for
low, medium and high variance ranges.
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l Don't benchmark items with fewer than <number> historical data points - Designate the
minimum number of data points needed to benchmark an item.

STEP BY STEP — OPENING THE JOB PROPERTIES FORM

1. On the Ribbon, select the Setup tab.

2. Under the Initialize section, select the Job Properties drop down arrow.

3. On the drop down list, select Benchmarking.

16 .1 .3 BENCHMARKING GRAPH

The defaults for the benchmarking graph are defined on the Job Properties - Benchmarking form, but
on the Cost Item Record - Benchmarking form you have the ability to override the default criteria in
order to expand or contract the amount of historical data being used to calculate benchmark values for
a specific cost item. This way, you can filter the historical data sources to only the past jobs that are
relevant to that cost item.
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Before starting this procedure, make sure to set up your default benchmarking options, as outlined in
the Benchmarking Options topic.

STEP BY STEP — BENCHMARKING GRAPH

1. From the Ribbon, select the Estimate tab. Under Breakdown Structures, select Cost Breakdown
Structure (CBS).

2. On the Cost Breakdown Structure (CBS) Register, select theMore Actions tab. Under the Tools
section, select Refresh Benchmarks.

3. The Refresh Benchmarks dialog shows the Last refresh date and the number of Jobs matching
filter criteria.

l If the number of matching jobs is too large or too small, return to step 1 and expand
or contract your filtering options.

l If the number of matching jobs is acceptable, click Refresh Now to proceed.

4. Open the Cost Item Record of any preferred cost item.

5. Click on the Benchmarking default data block located in the lower right portion of the Cost Item
Record.

6. The benchmarking graph shows the historical benchmark values for this cost item, along with the
Current value, the Average value, and the variance ranges represented by each color. This
information is calculated and displayed as specified on the Job Properties - Benchmarking form.
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7. To refine the values that contribute to this cost item's graph, click the Settings button to display
the Settings dialog:

l To override the job filter for this cost item, click the Edit button in the Override Jobs
Filter field and define the filter to use for benchmarking this cost item.

l To override the Display Options for this cost item, select the desired values from the
X-Axis and Y-Axis drop-down boxes.

l To override the list of jobs that contribute to the Included Historical Data for this cost
item, use the Auto include all matching data points toggle to include all or exclude all,
and select the individual Include check boxes for the jobs you want to include.

l When you have completed your customizations for this cost item's benchmarking,
click OK to save your changes and return to the Cost Item Record - Benchmarking
form.
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8. To zoom in on a portion of the graph, click and drag across the portion of the graph that you
want to enlarge. To view the entire graph again, click Reset Zoom.
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9. To print a Benchmark Report, click the Print button, change any options as necessary on the
Benchmark Report dialog, and click Run.
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16 .1 .4 ACCOUNT CODE UTIL IZAT ION REGISTER

The Account Code Utilization Register is used to roll estimate line items into an account code
hierarchy, with the ability to control which cost items contribute quantity to their parent, in order to
benchmark against historical projects in a way that is consistent across projects.

The Account Code Utilization Register is similar to the Cost Breakdown Structure (CBS) and theMaster
Cost Breakdown Structure (CBS), with the following exceptions:

l The rows in the Account Code Utilization Register represent Account Codes rather than
individual Cost Items, so the tree structure reflects the Account Code hierarchy rather than
the CBS hierarchy.
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l The detail rows in the Account Code Utilization Register reflect a terminal Account Code's
assigned Cost Items.

l The terminal rows in the Account Code Utilization Register represent each utilized
Account Code in the CBS.

l If the Account Code’s Auto-Quantity setting is set to Yes, then the Quantity of the terminal
row is equal to the Quantity (Primary or Secondary) of all the cost items in the CBS with
that assigned Account Code, and the cost items in the CBS employing resources with that
assigned Account Code, provided that they have the same Unit of Measure type as the
Account Code.

l Detail rows for each terminal row represent the cost items assigned to the terminal
Account Code, including cost items employing resources that are assigned to the terminal
Account Code.

l The Account Code Utilization Register can be filtered to display only terminal items by
clicking the drop down arrow on the Is Terminal column and selecting Checked.

l When an Account Code is assigned to an employed resource, the resource's total Cost/Mhrs are
removed from the Account Code associated with the cost item and placed, instead, in the
Account Code assigned to the employed resource.

The parent-child hierarchy for Account Codes is based on the Account Code Hierarchy Separator,
which is located from the Backstage View Settings under the Options drop down labeled as Account
Code Settings. The Hierarchy Separator defines the parent-child relationship within the Account Code
structure.

The Account Code Utilization Register is used primarily for analysis, and most of the columns are read-
only. Most of these columns originate on the Account Codes tab in the Foundation Setup Data
Register and theMaster Foundation Setup Data Register. Modifying an editable column on this form
has the same effect as modifying the same field on the Account Codes tab of the Foundation Setup
Data Register or on the Account Record. For further information, see Creating Account Codes.

The Benchmarking portion of the form is similar to the Benchmarking data block on the Cost Item
Record, with the following exceptions:

l The Item Matching criteria is always Account Code.
l Parent account codes will include all matching data points for their child account codes,
based on the Hierarchy Separator.

l Account Code rows can be benchmarked at the terminal row level or at any superior row
level in the Account Code Utilization Register, meaning that both current estimate values
and benchmark values can be compared at any level since both include the values rolled
up from their children.
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16.1.4 .1 OPENING THE ACCOUNT CODE UTILIZATION
REGISTER

STEP BY STEP — OPENING THE ACCOUNT CODE UTILIZATION
REGISTER

1. From the Backstage View, select Library from the left pane navigation.

2. From the Ribbon, select the Estimate tab.

3. Under the section Master Breakdown Structures, select Account Code Utilization. The Account
Code Utilization Register opens.
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EXERCISE 16.1 — BENCHMARKING SETUP

Your manager wants you to benchmark costs and man-hours against at least three past projects.

Help set up benchmarking accordingly. Be sure to:

l Use Default Account Code Matching Criteria

l Use Default Jobs Filter

l Benchmark Graph Display Options

Hints:

l The “Jobs matching filter criteria” indicates how many jobs it found a match for.

l A value of “0” means it didn’t find a match and the learner would need to double check their
benchmarking settings.

Congratulations, you have completed this exercise!
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LESSON 16 REVIEW

1. Where do you set up benchmarking matching criteria and display options?

a. Foundation Setup Data

b. Job Properties

c. Cost Breakdown Structure Register

d. Resource Rate Register

2. How do you make sure benchmarking data is up to date in the CBS Register?

a. Update settings in the Job Properties > Benchmarking tab

b. Select Update Graph on the Cost Item Record

c. Save the job

d. Select Refresh Benchmarks from the More Actions menu in the CBS

3. How can you view the benchmarking graph for a cost item?

a. Select the Benchmarking tab in Job Properties

b. Select the Benchmarking saved view in the CBS register

c. Select the Benchmarking tab on a cost item record

d. Select the Benchmarking report from the Reports menu

LESSON 16 SUMMARY

As a result of this lesson, you can:

l Set up and use benchmarking to compare your job to past projects
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LESSON 17 — CONFORM THE
EST IMATE

LESSON DURATION: 40 MINUTES

LESSON OBJECTIVES

After completing this lesson, you will be able to:

l Align Estimate data with Platform data in preparation for publishing the estimate

l Conform the estimate to publish successfully

l Publish the estimate to a project in Platform

l Review to confirm successful publishing of the estimate



17 . 1 CONFORM THE EST IMATE

The project estimate is often used as a starting point for the project budget. The estimate needs to be
conformed in preparation for project execution so there can be effective tracking, forecasting, and
reporting.

When you create a job in InEight Estimate in the cloud, you connect it to a project in InEight Platform.

In Estimate, you can publish the conformed estimate to become the project budget in InEight Control.

To successfully publish the estimate for project execution, you must perform the following:

l Align the Estimate and Platform data.

l Conform the estimate.

l Publish the estimate to a project in Platform.

l Review the project to confirm successful publishing of the estimate.

For more information, download the following documents from the Integrated Documents page:

Estimate Integration to Cloud Platform and Control for more detailed information about Estimate
integration to Platform.

Prepping Control Budget for Various Interfaces for detailed information about the preparation of a
project budget for implementation in Control.
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17 . 2 AL IGN EST IMATE AND PLATFORM DATA

You can align the Estimate data with Platform data to prepare the job in Estimate for publishing.
Alignment starts with creating a project in Platform, and then matching your estimate. For more
information about creating a project in Platform, see Project initiation.

CREATE A PLATFORM PROJECT

1. In Platform > Main menu > All projects & organizations, click the Add project icon to create a
new project.

2. Enter the Project ID and External Project ID.

3. Enter a project name in the Name field. The name does not have to match the ID, or the project
name in Estimate.

4. In Status, select New to execute the Publish Estimate to a New Project status. The budget
becomes initialized when the status is set to New.

5. In Phase, select Execution.

6. Select an organization from the list.

Next, create the estimate (job) in Estimate. You must select the Platform project to associate the
estimate to. Doing this updates the estimate with certain project details, such as notes, and location.

After you match the Platform project and the job in Estimate, you must check that the following data
matches between the two applications:

l Currency must match the project base currency for the project in Platform. Make sure the
currency symbol descriptions match in both Estimate and Control. For example, AUS dollars in
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Estimate must be AUS dollars in Control.

l Units of Measure names must exist in both Estimate and Platform.

l Account Code structure must be finalized to match Platform. Account codes are optional.

l Tags and User-defined fields from Estimate need to be configured at the organization or project
level in Platform.

l Cost Categories.

l Pay Item related fields.

The following are key considerations when conforming the estimate:

l Summarizing estimate details into logical work groupings, such as combining costs, quantities,
and work hours for work activities and resources.

l Breaking estimate structure into more detail (e.g., to track by area).

l Aligning the estimate data with an Account Code Structure.

l Conforming major materials from resources to cost items for better tracking.

l Moving, splitting, and combining cost items.

l Converting dependent cost items and cost item assemblies into standard cost items and
resources.

l Addressing suspended cost items. Suspended cost items do not go over to Control.

l Converting ad-hoc resources to a library resource or a plug value against a cost item.

l Addressing productivity factors by updating in Estimate to reflect the actual budgeted man-hours
that are required for the cost item in Control.

l Adding man-hours by creating a labor resource in Estimate or importing man-hours directly to
Control (when necessary).

l Establishing tag values imported from Estimate in Platform at the organization level.

l Configuring key pay item fields to match Control.

For more detailed information about Estimate integration to Platform, see Estimate Integration to
Cloud Platform and Control.

17 .2 .1 CONVERT DEPENDENT COST ITEM TO PLUG
COST ITEM

You must convert a dependent cost item to plug cost item as part of conforming the estimate. You can
do this in the CBS register of the estimate. For more information about dependent cost items, see
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Dependent cost items.

CONVERT DEPENDENT COST ITEM TO PLUG COST ITEM

1. Create a new cost item at the bottom of the CBS, and then enter a description for the dependent
cost item you’re replacing.

2. Select a unit of measure.

3. Open both the dependent cost item and new cost item.

4. Change the new cost item’s Cost Source to Plug.

5. Review the unit and total values in the dependent cost item’s cost category fields.

6. Copy or enter those values into the same cost category fields of the new cost item’s Plug tab.

Make sure contingency is represented on its own cost item. Contingency should not be
directly included in cost items where cost performance is required against budgeted
rates.

17 . 3 CONFORMING US ING OTHER
BREAKDOWN STRUCTURES

It is more efficient to track progress on your projects by organizing your budget in a more consolidated
and potentially different breakdown structure than how the job was estimated. Using account codes,
tag field values, or a work breakdown structure are common ways of viewing the estimate in an
alternate way. Most often one of these alternate views corresponds to the best way to structure the
budget to track the work.

17 .3 .1 CONFORMING BY ACCOUNT CODES

You can organize your budget by conforming your Estimate CBS structure to match a standard account
code structure.
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17 .3 .2 STEPS

CONFORM YOUR ESTIMATE USING AN ACCOUNT CODE STRUCTURE

1. Open a copy of the job in Estimate job that used for reference.

2. In the CBS register, group by Account Code.

3. Create a new job in Estimate, where items from the original estimate will be copied to.

l Assure that all job properties and settings match the original estimate file.

l Create any initial structure that is needed to organize your cost structure, such as General
Conditions, Direct Labor, Material and Subcontracts.

4. In the job with the grouped account codes, expand the first account code.

l When there is only one cost item, copy and paste it into the applicable location in the
conformance project.

l For account codes with multiple cost items, add a parent cost item to the conformance
project, and then copy and paste the cost items from the original estimate as
subordinates.
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It’s not required to have the account codes in Estimate, but using account codes in
Estimate can help to ensure accurate benchmarking functionality.

17 . 4 PUBL ISH TO PLATFORM PROJECT

When you are ready to publish the estimate, confirm that the project in Platform has the following
settings:

l Phase - Execution

l Status - New

17 .4 .1 PUBL ISH ESTIMATE TO A NEW PROJECT

To initialize a new control budget, publish the job in Estimate to become the project budget in Control,
click the Publish Estimate to a New Project option in the Integrations tab.
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When you publish an estimate to a new project, all cost items, pay items, and change orders that may
already exist in the project are removed.

When the integration process is successful, you receive an Import Success email.

17 .4 .2 PUBL ISH COST ITEMS TO AN ACTIVE
PROJECT

After an estimate has been published and progress is being tracked against a budget, it’s not
uncommon for new scope to be added to a project as the work progresses.

You can estimate the cost of this new scope using Estimate, and then publish the newly estimated
costs to a project in execution by using the Publish Cost Items to Active Project option.

Prior to publishing the cost items, change the status of the Platform project to Active.

17 .4 .3 UNSUCCESSFUL IMPORTS

When there are errors during the import, the import is unsuccessful. An InEight Notification email is
sent to you with a link to view the list of errors. Click the link shown under Summary to view the list of
errors. You can also access the App Logs in Estimate > Integrations > App Logs.
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Examples of failed import causes are:

l When a resource has more than 11 characters in front of the decimal. Cloud Platform only
accepts 11 numeric character places before the decimal, and 11 numeric character places after
the decimal.

l An account code assigned in Estimate that is not in the corporate list in project suite. The full
import might fail because there is nothing to roll up into the account code.

To access the app logs, you must have the DevOps Admin role.

After resolving errors, you can republish the estimate. Republishing the estimate also removes all cost
items, pay items, and change orders that were imported previously.

17 . 5 REV IEW PUBL ISHED DATA IN CONTROL

After a successful import, you can review the published data in Control. To review the data, go to
Control > Workspaces > Audit Log > Import history. You must manually refresh the import history to
see the newly updated import history data.

REVIEW PUBLISHED DATA IN CONTROL

1. In your project’s homepage, navigate to Control > Workspaces > Audit Log tab.

2. Select Import history in the left pane.

3. Select the Pending status for the newly imported line item.

4. Select the cost items you want to keep in Control.

5. Select Import.

You can’t add any cost items in the CBS or activate any syncs during the import
process.

6. Go to the Import history to view the import in process.

An email is sent to you that informs you whether the import succeeds or fails .

InEight Inc.  |  Release 24.9 Page 239 of 240

Estimate Intermediate User Guide 17.5 Review published data in Control



LESSON 17 REVIEW

1. Where would you go to review account codes and units of measure in InEight Estimate?

a. Pay Item & Proposal Register

b. Price Breakdown Structure

c. Job Properties

d. Foundation Setup Data

2. Which of the following needs to be converted when conforming the estimate?

a. Labor resources

b. Ad-hoc resources

c. Equipment resources

d. Supply resources

3. What phase does the project in InEight Platform need to be changed to prior to
publishing the estimate?

a. Initiation

b. Construction

c. Pre-execution

d. Execution

LESSON 17 SUMMARY

As a result of this lesson, you can:

l Align Estimate data with Platform data in preparation for publishing the estimate

l Conform the Estimate to publish successfully

l Publish the Estimate to a project in Platform

l Review to confirm successful publishing of the estimate
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